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INTRODUCTION

This programming guide is meant for users who want to convert data files into various
formats for the 8 series terminals.

Data Converter C++ APl and C# APl are functions performing file format conversion.
Both the API sets support three types of format conversion as follows:

» Text - CipherLab 8-Series Mobile Computer RAM

» Text - CipherLab 8-Series Mobile Computer SD card

» CipherLab 8-Series Mobile Computer SD card > text

Whether you are using C++ or .NET Framework for programming, it is easy to write
applications to convert data between PC and terminals. Supported data formats are
Forge AG, DBF, and ASCII.

We recommend that you read the documents thoroughly before use and keep it at hand
for quick reference.

Thank you for choosing CipherLab products!
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DEVELOPMENT TOOL

It is assumed that the programmer has prior knowledge of Windows programming. For
information on Windows application programming interface (APIl), essential online
resource is available on Microsoft website —

http://msdn2.microsoft.com/en-us/library/default.aspx

The development environment and tools can be one of the following choices:

» Visual Studio 2008
» Visual Studio 2005

Note: For the target application to run correctly on a system without Visual Studio 2008,
a prior installation of VC++ 2008 redistributable package is required.


http://msdn2.microsoft.com/en-us/library/default.aspx

C++ PROGRAMMING

Chapter 1

1.1 HOW TO CREATE A C++ CONSOLE PROJECT IN WINDOWS

1.1.1 USING VISUAL STUDIO IDE TO CREATE A C++ CONSOLE PROJECT

)
2)

3)

After launching the Visual Studio integrated development environment (IDE), please
point to New on the File menu, and then click Project.

When the New Project dialog shows up, click Win32 Console Application in the

Templates pane.

Give a name for the project and then click OK to create the project.

T st Page - Microsofe Visualswuaio N

File Edit View Tools Test Analyze Window Help

[EY RN =" W - NI NN

Solution Explorer

|an[nnl i

- S8 b | aIr-) (| HEEREa-L
~r
New Project = M
Project types: Templates: :NET Framework 3.5 - l
Visual C# Visual Studic installed templates
Other Languages =¥ Custom Wizard FATest Project
MeualGog FAwindows Forms Application Hcr Censole Application
':I:i lEWMEZ Console Application @ATL Project
% MFC Application [E] Makefile Project
General wa
MFC @ATL Smart Device Project FACIass Library Uy
Smart Device EICLR Empty Project CEmpty Project fan
Test fﬁMFC ActiveX Control fﬁMFC DLL
Win32 ;thMFC Smart Device ActiveX Control ;]ﬁMFC Smart Device Application b
Other Project Types affk MFC Smart Device DLL Ewin32 Project
Test Projects _-_E‘Wmﬂ Smart Device Project @Wmdows Forms Control Library flle
EWindows Service
My Templates ilo
j Search Online Templates..,
A project for creating a Win32 console application |4
Mame: SampleTest Ey
Location: D\ CipherlabDataConverter - g
Solution Name: SampleTest Create directory for solution
-
0K C |
] [ ancel l pl

Create a custom user control for Windows 8 using XAML and C#

J l Thu, 28 Mar 2013 16:10:04 Z - Watch this video to leam the 3 top async patterns and anti-patter

Visual Studio Headlines
Microsoft SDL Team Releases the
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1.1.2 IMPORTING LIBRARY

DATACONVERTER_CPP_API

The library files provided includes:

Folder Description

\include A bunch of header files

\lib CipherLab.DataConverter.lib (Data Converter API library)
CipherLab.DataConverter.dll (Data Converter API dIl)

Please copy the files listed above into your project directory.

ADD THE LIBRARY HEADER DIRECTORY

This is to tell the compiler where header files are located. Click Properties on the
Project menu to bring up the project’'s properties dialog. In the left pane, click the plus
sign to expand the Configuration Properties - C/C++ branch; then click General.

In the Additional Include Directories field of the right pane, add the “\include” folder.

Y Sompites - Micoso Voo s B

File Edit View Project Build Debug Tools Test Analyze Window Help

- i - 05 bl | % a9 - o - - EL| b Debug - Win32 - | TR R B
Bl a|EsE|=2 @l 3aEam 00
>§- Solution Explorer - SampleTest > 1 x main.cpp| Start Page
5 D | &
B Bl&|4 (Global Scope) -
g : %D'Ut\Dﬂ 'SampleTest' (1 project) B #ncly2
=] 33 SampleTest #incl| SampleTest Property Pages 2 ®
[ Header Files Fincl
-+ [ Resource Files using| | Configuration: |Active(Debug) -| Platform: [ Active(Win32) ~| [ configuration Manager... |
- | Source Files X
“o € maincpp E‘;“‘ b Commen Properties . Additional Include Directories
of Framework and Referen: Resolve #using Refgrenc
! E Configuration Properties Debug Informatiof Additional Include Directories S S i o
General Suppress Startup
Debugging Warning Level
C/Cr+ Detect 64-bit Port
Ganera.l X Treat Warnings A
Optimization Use UNICODE Res
Preprocessor
Code Generation £
Languagé Inherited values:
Precompiled Header
Output Files i
r— Browse Information
— Advanced
Error List | Command Line
@0 Errol Linker
Manifest Tool =
- (¥ Inherit from parent or project defaults -
De XML Document Generat b @ P ol W
||
Build Events ~ | | Specifies one or morf|
. |%‘ b than one.  (/I[path
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LINK TO STATIC LIBRARIES

This is to tell the linker where to find the library file(s). In the left pane, click the plus
sign to expand the Linker branch; then click General. Then in the Additional Library
Directories field of the right pane, add the “\lib” folder.

File Edit View Project Build Debug Tools Test Analyze Window Help

i3] + 4l - [ SampleTest Property Pages ‘7@ B |l@ﬂﬁ5’€ B -
[ e d
? E— Configuration: | Active(Debug) ¥ | Platform: | Active(Win32) V] [ Cenfiguration Manager... ]
olution
"
.E | ; | Optimization - Output File S(0utDin)\S({ProjectName).exe r
= [5] Soluti Preprocessor Show Progress Mot Set
= & A sa Code Generation Version
nable Incremental Linkin es
Language Enable I I Linking Yes (/INCREMENTAL)
4 Frecompiled Header| Suppress Startup Banner Yes (/NOLOGO)
- & Output Files Ignore Import Library Mo
Browse Information Register Qutput No
?dvaﬂcedd U Per-user Redirection No
Lk emmand Hne Additional Library Directories Di\GipherlabDataConverter\SampleTest\lib
inker - .
General Link Library Dependencies Yes
Input = Use Library Dependency Inputs M lilg\
" ) Use UNICODE Response Files v Additional Library Directories
Manifest File
Debugging
System - -
Optimization D:\CipherlabDataConverter\SampleTest\lib -
Embedded IDL -
Advanced | 1 ([} b
Cormmand Line
Manifest Tool Additional Library Directories P s
XML Document Generat _ Specifies one or more additional paths to seq|| : -;
4 ’% . semi-colon delimited list if more than one. oy ri
File

Inherit from parent or project defaults

Ready

Next, you have to tell the linker what library file(s) to use. In the left pane, click Input.
Then in the Additional Dependencies field of the right pane, add
“CipherLab.DataConverter.lib”.

O Sampierest - Micramon Vi sl

File Edit View Project Build Debug Tools Test Analyze Window Help

A=A N TN T SampleTest Property Pages . 2] = ]
o 2|38
¢ Solution Explorer - SampleTest + 4| Configuration: [Active(Debug) +| Platform: | Active(Win32) =] [ configuration Manager... |
2| | ] & |
g ha| & ‘ = : Optimization «| | Additional Dependencies
Az ?”";_:‘" SIZ:P‘ETE“ {1 project) Preprocessor Ignore Al Default Libraries o
] EEMHP deﬂH Code Generation Ignore Specific Library Additional Dependencies [BER =
..... = Raa er I:T Language Module Definition File
..... esource Files Precompiled Header Add Module to Assembly CipherLab.DataConverter.lib| m
& [ Source Files Outout Files - -
& msimepp P Embed Managed Resource File
Browse Information Force Symbol References
?""E”CE‘L . Delay Loaded DLLs
emmanetine Assembly Link Resource
Linker il L
General | Inherited values:
Input £
Manifest File (el e
Deb user32.lib E
ebugging gdiz2.lib
System winspool.lib
Optimization comdig32.lib
Embedded IDL =
Advanced =
Co:::::nd Line Inherit frem parent or project defaults
Manifest Tool Additional Dependencies
XML Document Generat | | specifies additional items to add to the lf]
‘ 1] L3
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LINKTO DLLS

Put CipherLab.DataConverter.dll in the same directory where the program’s executable
file is located.

In the main program, you could include “DataConverter.h” which contains all available
herders.

File Edit View Project Build Debug Tools Test Analyze Window Help

- - S H @ %G9 - S5 b Debug * Win32 - | - |l 5 Bl 1
I SR b oA E=2 083 B EaRBGE
g Solution Explorer - Solution 'SampleTest' (.. ~ & X Start Page | b main.cpp
o2 E e
?F | é'j | 5 < (Glebal Scope) - =¢mam0
& | m S_'OIUtlon SampleTest’ (1 project) a#include "DataConverter h"
- (53 SampleTest #include <iostrean=
[ Header Files #include <stdio.hs
: £ Resource Files #include =cstdlibes
= [ Source Files using namespace Cipherlab::DataConverter;
o mein.cpp S int maing}
bpiTersion s;
cout << "werzion: " << z_GetdpiVersion{) << endl;
return 0;
4 m
Error List
|Q 1] Errors|||l_$0 Wamings|||@ 0 Messages
Description
Ready
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1.2 HOW TO CREATE A C++ CONSOLE PROJECT IN LINUX

For now only Linux with the GNU C++ compiler version ranging from 4.8.4 to 5 is
supported.

1.2.1 FOR AMD64

) Use Code::Block IDE to create a C++ console project. On the File menu, point to
New, and then click Project. Select Console application.
File Edit View Search Project Build Debug Tools Plugins Settings Help
FeB8 e

[

2 Q m:_,|§ @ > % @ B Debug reavsacuna 5E

Management ® start here
Projects |symbols |
@ Workspace El. nNewfromtempate [
] x

Category: <Al categories= -| Go |
5.“.3 @ @ Cancel |

.’.\.
ARM Project FLTK project
==
° &h
AVR Project D application Fortran DLL
e =
| Ly,

CodeBlocks plugin Empty project Fortran applicati

Build targets
Files
Custom
User templates

~View as
® Large icons

| ] O List
TIP: Try rightclicking an item

1. Select a wizard type first on the left

2. select a specific wizard from the main window (Filter by categories if needed)
3.Press Go

No recent files

Logs & others

/| Codex:Blocks 3% ' searchresults 3¢ & Debugger 3

© Buildlog 3¢ ¥ Build message

2) Copy both “\include” and “\lib” folders into your project directory.
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3) Click Project - Build options - Compiler settings > Other options to add compiler
options:

» -lpthread
> -Im
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4) Click Project - Build options - Compiler settings - #defines to add compiler defined
variables:

» _GLIBCXX_USE_CXX11_ABI=0

GLIBCKX_USE_CXX11_ABI=0
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5) Click Project - Build options - Linker settings - Link libraries to add link libraries:
» Add the “Linux amdé64/libDataConverter.a” which is located in the lib folder.
» Add “libpthread.so” which is located in the “/usr/lib/x86_64-linux-gnu” folder.

J2.2.0Mib/Linux amdB4/libDataConverter.a
Lol tusrllib/x86_B4-linux-gnu/libpthread.so

10
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6) Click Project -> Build options > Search Directories - Compiler to add search
directories for the compiler:

» Add the “include” folder.

7) In the main program, you can simply include “DataConverter.h” which contains all
available headers.

) Use Code::Block IDE to create a C++ console project. On the File menu, point to
New, and then click Project. Select Console application.
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File Edit View Search Project Build Debug Tools Plugins Settings Help

seB@® «3sea/An]sr ¢ o a b freevcscvnang
] d
Mana?ement = start here 33«|
Projects symbolsl
@ wWorkspace El. nNewfromtempate [
(] nNewfromtemplate [

O[S Category: <l categories> | [ e ]

Build targets

§ e @ Cancel |
Files g e | ﬁ( v/

custom ARM Project nsole application FLTK project
User templates ) 2ep prel

° ) L)

AVR Project D application Fortran DLL
b =
| Lt

CodeBlocks plugin Empty project Fortran applicati

~View as
® Large icons

| 0| O List
TIP: Try rightclicking an item

1. Select a wizard type first on the left

2. select a specific wizard From the main window (Filter by categories if needed)
3. Press Go

No recent files

'Lngs&m:hels

/| Code::Blocks 3 - Searchresults 3¢ & Debugger i |&)uildlog 3¢ ¥ Build message

File Edit View Search Project Build Debug Tools Plugins Set.tings'Help
H =~ - NI T %%I?@Es B> % © @ Debug vlé C L L S S S T ] E.‘?."‘.:|

[~ |

Management (]

- Start here 3
Projects |Sy|11bols |
&) workspace
" Code::Bloc
Console application o x|
Please select the compiler to use and which configurations
E Console you want enabled in your project.

Compiler:

GNU GCC Compiler LI

Create "Debug” configuration: |Debug
"Debug" options |
‘Qutput dir.; |I3In,fDnebug,|r ‘
Objects output dir.: ]obj,fDebug,.f ‘

Create "Release” configuration: |Release
"Rel " options
Output dir.: |bin/Release/ |
‘Objects output dir.: ]obij:leas e/ ‘

<Back I Q)Cancell
|Logs & others
/| codezBlocks % | -4 Searchresults 3¢ # |83 Bul i | ¥ Buildmessages it
/| CodezBlocks 3 4 hresults 3¢ © Debugger & puild 3| ¥ Build ges i

2) Copy both “\include” and “\lib” folders into your project directory.
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3) Click Project - Build options - Compiler settings - Other options to add
compiler options:

» -lpthread

> -Im

File Edit View Search Project Build Debug Tools Plugins Settings Help
iJeE@ +3 #6a Aa) o> ¢ on b NI TR
| 1 d|
Management
Projects |Symbols |
g Projectbuildoptions _________________[1
= () Workspace — =
= ‘m ~sample Selected compiler
b B Sources Debug GNU GCC Compiler |v|
:
4 CompilersettingSI Llnkerser.tings| Seard'ldirea.orlesl Pre,l’postbuildshepsl’
Policy: Append target options to project options. vl
compiler Flags Other options | ndeﬁnesl
Hpthread
Im

Logs & others

/| Code::Blo

et variable
tarting deb
one

o e
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4) Click Project > Build options »> Compiler settings > #defines to add compiler
defined variables:

» _GLIBCXX_USE_CXX11_ABI=0
B

Management

Projects | Symbols |

main.cpp % |

% Project build options x
7 @ workspace Selected cumpiler—h

- SET =l |
+ B sources bug GNU GCC Compiler - |
elease

_I main.cpp 4 Cnrnpilersettingsl Linkersettingsl Searchdirectoriesl Pre]postbuildstepsl’

Policy: Append target options to project options ['l

Compiler Flagsl Other options #defines |

[ GLIBCXX_USE_CXX11_ABI=0

@ Cancel
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5) Click Project > Build options > Linker settings - Link libraries to add link
libraries:

» Add the “Linux i386/libDataConverter.a” which is located in the lib folder.
» Add “libpthread.so” which is located in the “/usr/Iib/i386-linux-gnu” folder.

Management .
main.cpp 3

Projeckts |5 bols ——— e
i | 2] Project build options x

= O Workspace Selected compiler

- wEm e |
< B Sources ehuy GNU GCC Compiler [ |
\elease

- main.cpp 4 Compiler settings  Linker settings | Search directories | Pre/post build steps | >
Policy: Append target options to project options [v |
-Link libraries: other linker options:

lib/Linux i386/libDataConverter.a

f - Jusiflib/i386-linux-gnu/libpt

T | |

' ﬂl Delete El

Copy selected to... |

@ Cancel | <Fok |
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6) Click Project »> Build options > Search Directories - Compiler to add search
directories for the compiler:

» Add the “include” folder.

Management ®

Projects |Symbol.s |

= {3 workspace
- ‘m sample Selected compiler
~ [ Spurces Debug GMU GCC Compiler - |
I -Relaase :
main.cpp
4 compiler settings | Linker settings  Search directories ‘ Pre/post build steps |P
Compiler | l.inker‘ Resource compiler
Policy: Append target options to project options |v|
include
Log=aatners IAddl Edit ‘ Delete Clear | Copyto... |
) €od
14 bl
tarting debi @cancel | <Tok
one

7) In the main program, you can simply include “DataConverter.h” which contains all
available headers.
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1.3 SAMPLE CODE

#include "DataConverter.h"

#include <iostream=

#include <stdio.h>

#include <cstdlib>

#if defined _ WIN32 || defined _WING64
#else

#include <unistd.h>

#Hendif

using namespace std;

void progressCallBack_dbf2txt(float percent, int recordCount, const char* status)

{
printf("Percentage: %.02f ", percent);
printf("RecordCount: %d ", recordCount);
printf("Status: %snn", status);

by

int main()

{

ProgressCallBack* cbPtr = new ProgressCallBack();

cbPtr->SetCallBack(progressCallBack_dbf2txt);

#if defined _WIN32 || defined _WIN64
string srcC = "D://DC//testing folder//txt2dbf_c//input4.DB0";
string tarC = "D://DC//testing folder//dbf2txt_c//input4.TXT";

#Helse
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string srcC = "/home/DC/testing folder/txt2dbf_c/input_4f.DBO";
string tarC = "/home/DC/testing folder/dbf2txt_c/nput4.TXT";

#Hendif

Dbf2TxtConverter* d2tObj = new Dbf2TxtConverter(C, srcC.c_str(), tarC.c_str());
try{
d2tObj->ConvertAsync(cbPtr);
d2tObj->CancelAsync();
ConversionResult* result = d2tObj->result;
cout << "status=" << endl;
switch(result->status)
{
case Failed:
cout << "Failed"” << endl;
break;
case Cancelled:
cout << "Cancelled” << endl;
break;
#if defined _WIN32 || defined _WIN64
case CipherLab::DataConverter::Unknown:
#Helse
case Unknown:
#Hendif
cout << "Unknown" << endl;
break;
case SucceededWithRecordsSkipped:

cout << "SucceededWithRecordsSkipped" << endl;
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break;
case Succeeded:
cout << "Succeeded" << endl;
break;
default:
cout << "Totally Unknown" << endl;
}
cout << "Output File Paths: " << endl;
for(inti = O; i < result->getNumberOfOutputFiles(); i++)

{

cout << i << ") " << result->getOutputFilePaths(i) << endl;
¥
cout << "ErrorRecord: " << endl;

for(int i = 0; i < result-=getNumberOfErrorRecords(); i++)

{
ErrorRecord e = result->getErrorRecord(i);
cout << i<<"):";
cout << "filename =" << e.getFileName() << endl;
cout << e.getRecordNum() << endl;
cout << e.getRecordText() << endl;
}

}catch (formatException& e)

{
cerr << e.getMessage() << endl;
getchar();
exit(0);

¥
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#if defined _WIN32 || defined _WIN64
cin.get();//pause console to see the message
#else
sleep(10);

#Hendif

return O;

}
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1.4 ENUMERATIONS

1.4.1 AGXTYPE

The AGXType enumeration defines the type of AGX format for 8-series.
Syntax

typedef enum

{
Series86;
Series86_Encrypted;
Others;
Others_Encrypted;

} AGXType;

Members
Series86
The AGX format type for the 8600 model.
Series86_Encrypted
The AGX format type generated by Forge AG v2.0 or later for the 8600 model.
Others
The AGX format type for 8-series except for the 8600 model.
Others
The AGX format type generated by Forge AG v2.0 or later for 8-series except for the
8600 model.

1.4.2 BASICPROGDBFFILENAME

The BasicProgDbfFileName enumeration defines the DBF file names for Basic
programming record format.

Syntax
typedef enum
{
F1;
F2;
F3;
F4;
F5;
} BasicProgDbfFileName;

Members
F1

The file name part of the DBF file is F1.
F2

The file name part of the DBF file is F2.
F3

The file name part of the DBF file is F3.
F4

The file name part of the DBF file is F4.
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F5
The file name part of the DBF file is F5.

1.4.3 CONVERSIONSTATUS

The ConversionStatus enumeration defines the current status of conversion process.

Syntax

typedef enum

{
Failed;
Cancelled;
Unknown;
SucceededWithRecordsSkipped;
Succeeded;

} ConversionStatus;

Members
Failed

Conversion status is failed.
Others

Conversion status is cancelled.
Unknown

Conversion status is unknown.
SucceededWithRecordsSkipped

Conversion status is succeeded with records skipped.
Succeeded

Conversion status is succeeded.

1.4.4 FILETYPE

The FileType enumeration defines the type of file for doing DBF to PC conversion.

Syntax

typedef enum

{
Unknown;
Lookup;
Transaction;

} FileType;

Members
Unknown

Unknown file.
Lookup

A lookup file.
Transaction

A transaction file.
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1.4.5 FORGEAGPROGDBFFILENAME

The ForgeAgProgDbfFileName enumeration defines the type of lookup file for Forge
AG programming record format.

Syntax

typedef enum

{
FirstLookup;
SecondLookup;
ThirdLookup;

} ForgeAgProgDbfFileName;

Members
FirstLookup

The first lookup file.
SecondLookup

The second lookup file.
ThirdLookup

The third lookup file.

1.4.6 PROGRAMMINGTOOL

The ProgrammingTool enumeration defines the programming tool employed by users
to program the application.

Syntax

typedef enum

{
C;
Basic;
ForgeAdg;

} ProgrammingTool;

Members
C
C programming tool.
Basic
Basic programming tool.
ForgeAg
Forge Ag programming tool.

1.4.7 WRONGFORMATACTION

The WrongFormatAction enumeration defines the actions to take when encountering
wrong data format during conversion.

Syntax

| typedef enum
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Stop;
Reformat;
SKip;

} WrongFormatAction;

Members
Stop

Stop the conversion process when data format is not correct.
Reformat

Reformat the data record when the format is not correct.
Skip

Skip the current record and continue with the next record.
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1.5 CLASS

1.5.1 AGX

Reads data format from an AGX file.
Header File: #include <AGX.h>

Static Public Member Function:

DLLEXPORT static int DetermineFormatType (const char *path)

To determine the format type of the AGX file.

static DLLEXPORT ForgeAgProgDataFormat *Read (const *path, int &counter)

Reads record format details from the AGX file.

DETERMINEFORMATTYPE

Syntax

int CipherLab::DataConverter::AGX::DetermineFormatType (const char *path) [static]

Parameters
path
The AGX file path.
Return Value
AGXType with success; or -1 indicating unable to open the file.

Example

string path2 = "D:\\DC\\testing folder\\agx\\8600_Basic_Testl.AGX";
int val2 = AGX::DetermineFormatType(path2.c_str());
cout << "fileType =" ;
switch(val2)
{
case CipherLab::DataConverter::Series86:
cout << "Series86" << endl;
break;
case CipherLab::DataConverter::Series86_Encrypted:

cout << "Series86_Encrypted" << endl;

break;
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case CipherLab::DataConverter::Others:
cout << "Others" << endl;
break;
case CipherLab::DataConverter::Others_Encrypted:
cout << "Others_Encrypte" << endl;
break;
default:

cout << "Cannot open file" << endl;

}

READ

Syntax

ForgeAgProgDataFormat *CipherLab::DataConverter::AGX::Read (const char *path, int
&counter) [static]

Parameters
path

The AGX file path.
counter

The number of records that reference the number of records of
ForgeAgProgDataFormat.

Return Value
ForgeAgProgDataFormat.

Example

string path = "D:\\DC\\testing folder\\agx\\82_susan_ fixed.AGX";
int numOfLookup = 0O;
ForgeAgProgDataFormat *for86df = AGX::Read(path2.c_str(), numOfLookup);

for(inti = O; i < numOfLookup; i++)
{
cout << "[" << i << "] DbfFileName: " << for86df[i].DbfFileName << endl;
cout << for86df[i].actionTakenWhenFormatlsWrong << endl;
for(int j= O; j < for86df[i].getNumberOfRecordFields(); j++)
{

26




Chapter 1 C++ Programming

RecordField rec = for86df[i].GetRecordFieldAt(j);

cout << "[" << j << "] Length(" << rec.Length << ") Offset(" << rec.Position

<< ") Key(" << rec.IsKey << ")" << endl;

1.5.2 APIVERSION

Retrieves version information for the Converter C++ API.

Header File: #include <APIVersion.h>

Public Member Function:

DLLEXPORT ApiVersion ()

Constructor of the ApiVersion class.

DLLEXPORT ~ApiVersion()

Destructor of the ApiVersion class.

DLLEXPORT int GetApi_build_version ()

Gets API build number.

DLLEXPORT int GetApi_major_version ()

Gets APl major number.

DLLEXPORT int GetApi_minor_version ()

Gets APl minor number.

DLLEXPORT const char *GetApiVersion()

Gets API version info in const char*.

GETAPI_BUILD_VERSION

Syntax

int CipherLab::DataConverter::ApiVersion::GetApi_build_version ()

Return Value

int APl build number

GETAPI_MAJOR_VERSION

Syntax
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int CipherLab::DataConverter::ApiVersion::GetApi_major_version ()

Return Value

int APl major number

GETAPI_MINOR_VERSION

Syntax

int CipherLab::DataConverter::ApiVersion::GetApi_minor_version ()

Return Value

int APl minor number

GETAPIVERSION

Syntax

int CipherLab::DataConverter::ApiVersion::GetApiVersion ()

Return Value

const char* API version

1.5.3 BASICPROGDATAFORMAT

Inherits CipherLab::DataConverter::DataFormat

Public Member Function:

DLLEXPORT BasicProgDataFormat ()

Default constructor of the BasicProgDataFormat class.

DLLEXPORT BasicProgDataFormat (const char *path, BasicProgDbfFileName
dbfFileName)

Constructor of the BasicProgDataFormat class.

DLLEXPORT BasicProgDataFormat (const char *path, BasicProgDbfFileName
dbfFileName, char delimiter)

Constructor of the BasicProgDataFormat class.

DLLEXPORT ~BasicProgDataFormat ()

Destructor of the BasicProgDataFormat class.

Public Attribute:

28




Chapter 1 C++ Programming

BasicProgDbfFileName

The output DBF file name of BasicProgDataFormat.
Additional Inherited Member:

Syntax

CipherLab::DataConverter::BasicProgDataFormat: :BasicProgDataFormat (const char
*path, BasicProgDbfFileName dbfFileName)

Constructor of the BasicDataFormat class.
Parameters
path

Specifies the file path.
dbfFileName

The output DBF file name.

Syntax

CipherLab::DataConverter::BasicProgDataFormat: :BasicProgDataFormat (const char
*path, BasicProgDbfFileName dbfFileName, char delimiter)

Constructor of the BasicDataFormat class.
Parameters
path
The file path.
dbfFileName
The output DBF file name.
delimiter
The delimiter character used in the record to separate data.

Remarks

> The maximum number of record fields for both non-8600 models and 8600 model is
8.

) Txt2PackedDbf conversion:

For non-8600 model, the format can have 1—~3 key fields specified; as for 8600 model,
the format can have 0—5 key fields specified.

> Txt2Dbf conversion:
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For non-8600 model, the format can have 0—3 key fields specified; as for 8600 model,
the format can have 0—5 key fields specified.

1.5.4 CONVERSIONRESULT

Gets the post conversion result including the possible ErrorRecord list and the output file
paths.

Header File: #include <ConversionResult.h>

Public Member Function:

ConversionResult ()

Constructor of the ConversionResult class.

~ConversionResult ()

Destructor of the ConversionResult class.

ErrorRecord getErrorRecord (int index)

Returns the error record with specific index.

int getNumberOfErrorRecords ()

Returns the number of error records.

int getNumberOfOutputFiles ()

Returns the number of output files.

const char *GetOutputFilePaths(int index)

Returns the output file’s path with specific index.

Public Attribute:

ConversionStatus status

Static Public Attribute:

static std::vector<ErrorRecord>errorRecordList

static std::vector<string=>outputFilePaths

1.5.5 CPROGDATAFORMAT

Inherits CipherLab::DataConverter::DataFormat.

Public Member Function:

DLLEXPORT CProgDataFormat ()
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Constructor of the CProgDataFormat class.

DLLEXPORT CProgDataFormat (const char *path, const char *dbfFileName)

Constructor of the CProgDataFormat class.

DLLEXPORT CProgDataFormat (const char *path, const char *dbfFileName, char
delimiter)

Constructor of the CProgDataFormat class.

DLLEXPORT ~CProgDataFormat ()

Destructor of the CProgDataFormat class.

Public Attribute:

const char *DbfFileName

The output DBF file name of CProgDataFormat.
Additional Inherited Member:

Syntax

CipherLab::DataConverter::CProgDataFormat: :CProgDataFormat (const char *path,
const char *dbfFileName)

Constructor of the CDataFormat class.
Parameters
path

The input file path.
dbfFileName

The output DBF file name.

Syntax

CipherLab::DataConverter::CProgDataFormat: :CProgDataFormat (const char *path,
const char *dbfFileName, char delimiter)

Constructor of the CDataFormat class.
Parameters
path

The input file path.
dbfFileName

The output DBF file name.
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delimiter
The delimiter character used in the record to separate data.

Remarks

» The maximum number of record fields for both non-8600 models and 8600 model is
8.

> Txt2PackedDbf conversion:

For non-8600 model, the format can have 1—8 key fields specified; as for 8600 model,
the format can have 0—8 key fields specified.

> Txt2Dbf conversion:

For both non-8600 modesl and 8600 model, the format can have 0—8 key fields
specified.

1.5.6 DATAFORMAT

Inherited by CipherLab::DataConverter::BasicProgDataFormat,
CipherLab::DataConverter::CProgDataFormat, and
CipherLab::DataConverter::ForgeAgProgDataFormat.

Public Member Function:

DataFormat (int maxFields, char delimiter=0x00)

Constructor of the DataFormat class.

~DataFormat ()

Destructor of the DataFormat class.

void AddRecordField (RecordField recordField)

Adds a recordField to the DataFormat class.

void ClearRecordFields ()

Clear the record fields in a data format.

void EditRecordFieldlsKey (int index, bool isKey)

Edit a specific record field whether it’s a key field or not.

void EditRecordFieldLength (int index, int length)

Edit a specific record field’s length.

void EditRecordFieldPosition (int index, int position)

Edit a specific record field’s position.

const char *getDbfFileName ()
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Get the output DBF file name.

char getDelimiter ()

Get the delimiter character.

int getKeyCount ()

Get the number of key fields in the data format.

int getMaxRecordFields ()

Get the maximum record fields in the data format.

int getNumberOfRecordFields ()

Get the number of record fields in the data format.

const char *getPath ()

Get the input path.

RecordField GetRecordFieldAt (int index)

Gets a recordfield from the specified location.

bool isRecordDelimited ()

Check whether the record data is delimited.

void ParseRecordFields (const char *inputFilePath)

Parse the input file to generate the vector of record fields.

void setDbfFileName (const char *fileName)

Set the output DBF file name.

void setDelimiter (char ch)

Set the delimiter character.

void setPath (const char *path)

Set the input path.

Protected Attribute:

const char *dbfFileName
char delimiter

int maxFieldLength

int maxFieldPosition

int maxRecordFields
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int minFieldLength
int minFieldPosition
string path

vector< RecordField > RecordFields

CONSTRUCTOR & DESTRUCTOR

Syntax

CipherLab::DataConverter::DataFormat::DataFormat (int maxFields, char delimiter =
0x00)

Constructor of the DataFormat class.
Parameters
maxFields
The maximum number of fields in the data format.
delimiter

The delimiter character used in the record to separate data.

DETAILS OF MEMBER FUNCTION

Syntax

void CipherLab::DataConverter::DataFormat::AddRecordField (RecordField recordField)

Adds a RecordField object to the DataFormat class.
Parameters
recordField

A RecordField object.

Syntax

void CipherLab::DataConverter::DataFormat: :EditRecordFieldlsKey (int index, bool
isKey)

Edits a specific record field whether it’s a key field or not.
Parameters

index
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The index of the record field.
isKey
Changes the specific record field whether it’s a key field or not.

Syntax

void CipherLab::DataConverter::DataFormat::EditRecordFieldLength (int index, int
length)

Edits a specific record field’s length.
Parameters
index

The index of the record field.
length

The new length of the record field.

Syntax

void CipherLab::DataConverter::DataFormat: :EditRecordFieldPosition (int index, int
position)

Edits a specific record field’s position.
Parameters
index

The index of the record field.
position

The new position of the record field.

Syntax

int CipherLab::DataConverter::DataFormat::getkKeyCount ()

Gets the number of key fields in the data format.
Return Value
The number of key fields in the data format.

Syntax

int CipherLab::DataConverter::DataFormat::getMaxRecordFields ()

Gets the maximum record fields in the data format.
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Return Value
The maximum record fields in the data format.

Syntax

int CipherLab::DataConverter::DataFormat::getNumberOfRecordFields ()

Gets the number of record fields in the data format.
Return Value
The number of record fields in the data format.

Syntax

RecordField CipherLab::DataConverter::DataFormat: :GetRecordFieldAt (int index)

Gets a record field from the specified location.
Parameters
index

The index of the record field.

Syntax

void CipherLab::DataConverter::DataFormat: :ParseRecordFields ( const char
*inputFilePath )

Parses the input file to generate the vector of record fields.
Return Value
The vector of record fields.

Syntax

void CipherLab::DataConverter::DataFormat: :setDbfFileName ( const char *fileName )

Sets the output DBF file name.
Parameters
fileName

The output DBF file name.

1.5.7 DBF2TXTCONVERTER

Converts DBF files or transaction (DAT) files on SD card to text files.

Header File: #include <Dbf2TxtConverter.h>
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Public Member Function:

DLLEXPORT Dbf2TxtConverter (ProgrammingTool tool, const char *source, const char
*target)

Initializes a new instance of the Dbf2TxtConverter class with programming data format.

DLLEXPORT void CancelAsync ()

Requests cancellation of asynchronous conversion.

DLLEXPORT void Convert (ProgressCallBack *cbPtr)

Requests conversion.

DLLEXPORT void ConvertAsync (ProgressCallBack *cb)

Requests action of asynchronous conversion.

Public Attribute:

ConversionResult *result

Points to the ConversionResult object for conversion result.

DETAILS OF MEMBER FUNCTION

Syntax

void CipherLab::DataConverter::Dbf2TxtConverter::ConvertAsync (ProgressCallBack
*cb)

Requests action of asynchronous conversion.
Parameters
cb

A function pointing to the user-defined progress report function. If there is no
need to report progress, set cb to NULL.

Example

#include "DataConverter.h"

#include <iostream=> //for cin, cout and endl
#include <string.h>

#include <stdio.h>

#include <cstdlib>

using namespace std;
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using namespace CipherLab::DataConverter;

void progressCallBack(float percent, int recordCount, const char* status)
{

printf("Percentage: %.02f ", percent);

printf("RecordCount: %d ", recordCount);

printf("Status: %s\n", status);

int main()
{
ProgressCallBack* cbPtr = new ProgressCallBack();

cbPtr->SetCallBack(progressCallBack);

string srcC = "D:\\DC\\testing folder\\txt2dbf_ c\\input4.DB0";
string tarC = "D:\\DC\\testing folder\\dbf2txt_c\\input4.TXT";

Dbf2TxtConverter* d2tObj = new Dbf2TxtConverter(C, srcC.c_str(), tarC.c_str());
try{

d2tObj->ConvertAsync(cbPtr);
d2tObj->CancelAsync();

}catch (formatException& e)

{

cerr << e.getMessage() << endl;

getchar();

exit(0);

¥

cin.get();//pause console to see the message

return O;

by

1.5.8 ERRORRECORD

Records errors during processing data conversion.
Header File: #include <ErrorRecord.h>

Public Member Function:
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ErrorRecord (string fileName, long recordNum, string recordText, bool isSkip)

Constructor of ErrorRecord.

ErrorRecord ()

Default Constructor of ErrorRecord.

~ErrorRecord ()

Destructor of ErrorRecord.

const char *getFileName ()

Gets the input file name.

long getRecordNum ()

Gets the sequence of the record.

const char *getRecordText ()

Gets the text of record.

bool isSkipped ()

Determines whether the ErrorRecord is skipped.

CONSTRUCTOR & DESTRUCTOR

Syntax

CipherLab::DataConverter::ErrorRecord::ErrorRecord (string fileName, long recordNum,

string recordText, bool isSkip)

Constructor of ErrorRecord.
Parameters
fileName

The input file name.

recordNum

Identifies the sequence of the record.

recordText
Identifies the text of record.

isSkip
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Identifies whether the action to take when detecting wrong data format during
conversion is ‘skip’ or not.

Return Value

Object which contains the error info when detecting wrong data format during
conversion.

1.5.9 FORGEAGPROGDATAFORMAT

Inherits CipherLab::DataConverter::DataFormat.

Public Member Function:

DLLEXPORT ForgeAgProgDataFormat ()

Default Constructor of ForgeAgProgDataFormat class.

DLLEXPORT ForgeAgProgDataFormat (const char *path, ForgeAgProgDbfFileName
dbfFileName)

Constructor of ForgeAgProgDataFormat class.

DLLEXPORT ForgeAgProgDataFormat (const char *path, ForgeAgProgDbfFileName
dbfFileName, char delimiter)

Constructor of ForgeAgProgDataFormat class.

DLLEXPORT ~ForgeAgProgDataFormat ()

Destructor of ForgeAgProgDataFormat class.

DLLEXPORT void AddRecordField (RecordField recordField)

Adds a record field to the data format.

DLLEXPORT int getKeylndex ()

Gets the index of key field.

DLLEXPORT RecordField getKeyRecordField ()

Gets the key record field.

Public Attribute:

WrongFormatAction actionTakenWhenFormatlsWrong

The action to take when detecting wrong data format during conversion.

ForgeAgProgDbfFileName DbfFileName

The output DBF file name of ForgeAgProgDataFormat.

Additional Inherited Member:
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Syntax

CipherLab::DataConverter::ForgeAgProgDataFormat::ForgeAgProgDataFormat (const
char *path, ForgeAgProgDbfFileName dbfFileName)

Constructor of the ForgeAgProgDataFormat class.
Parameters
path
The input file path.
dbfFileName

The output DBF file name.

CipherLab::DataConverter::ForgeAgProgDataFormat: :ForgeAgProgDataFormat (const
char *path, ForgeAgProgDbfFileName dbfFileName, char delimiter)

Constructor of the ForgeAgProgDataFormat class.
Parameters
path
The input file path.
dbfFileName
The output DBF file name.
delimiter
The delimiter character used in the record to separate data.

Remarks

> The maximum number of record fields for non-8600 models is 8; as for 8600, the
maximum number of record fields is 12.

) For both Txt2PackedDbf conversion and Txt2Dbf conversions, the format must have
one and only one key field specified.

1.5.10 FORMATEXCEPTION
Inherits exception.

Header File: #include <FormatException.h>

Public Member Function:

formatException (void)

Default constructor of the formatException class.
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formatException (string message, string info="")

Constructor of the formatException class.

~formatException (void) throw ()

Destructor of the formatException class.

string getMessage ()

Return the runtime exception message.

1.5.11 RECORDFIELD

The RecordField class.
Header File: #include <RecordField.h>

Public Member Function:

RecordField (int position, int length, bool isKey)

RecordField constructor takes 3 parameters.

RecordField (int position, int length)

RecordField constructor takes 2 parameters.

RecordField ()

Default constructor of RecordField class.

Public Attribute:

bool IsKey

A public member boolean variable.

int Length

A public member integer variable.

int Position

A public member integer variable.

CONSTRUCTOR & DESTRUCTOR

Syntax

CipherLab::DataConverter::RecordField::RecordField (int position, int length, bool isKey)

RecordField constructor takes 3 parameters.
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Parameters
position
The start position of the record field in specific line content.
length
The length of the record field.
isKey
To determine whether the record field is a key field.

Syntax

CipherLab::DataConverter::RecordField::RecordField (int position, int length)

RecordField constructor takes 2 parameters.
Parameters
position
The start position of the record field in specific line content.
length

The length of the record field.

DETAILS OF MEMBER DATA

Syntax

bool CipherLab::DataConverter::RecordField::IsKey

A public member boolean variable (no matter whether the record field is a key field or
not).

int CipherLab::DataConverter::RecordField::Length

A public member integer variable (the length of the record field).

int CipherLab::DataConverter::RecordField: :Position

A public member integer variable (the start position of the record field).

1.5.12 PROGRESSCALLBACK

Have the converting function acting as a callback function to report the percentage,
record count, and status of conversion process.

Syntax
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CipherLab::DataConverter::ProgressCallBack (void)

Default constructor of ProgressCallBack

void CipherLab::DataConverter::SetCallBack (CBFun fun)

Register fn as a callback function to be called automatically for conversion.
Parameters
fun
Pointer to the function to be called. The CBFun member type is defined as:
typedef void (*CBFun) (float percentage, int recordCount, const char* status);
percentage
the current percentage of process.
recordCount
the current processed record count.
status

the processing status.

1.5.13 TXT2DBFCONVERTER

Public Member Function:

DLLEXPORT Txt2DbfConverter (BasicProgDataFormat &dataFormat, const char
*targetDir, Wrong FormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2DbfConverter class in basic programming data
format.

DLLEXPORT Txt2DbfConverter (CProgDataFormat &dataFormat, const char *targetDir,
WrongFormat Action actionTakenWhenWrong)

Initializes a new instance of the Txt2DbfConverter class in C programming data format.

DLLEXPORT Txt2DbfConverter (ForgeAgProgDataFormat &dataFormat, const char
*targetDir, Wrong FormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2DbfConverter class in Forge AG programming data
format.

DLLEXPORT ~Txt2DbfConverter ()
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Destructor of the Txt2DbfConverter class.

DLLEXPORT void CancelAsync ()

Requests cancellation of asynchronous conversion.

DLLEXPORT ConversionResult Convert (ProgressCallBack *cb)

Requests conversion.

DLLEXPORT void ConvertAsync (ProgressCallBack *cb)

Requests action of asynchronous conversion.

Public Attribute:

ConversionResult result

The ConversionResult object for conversion result.

ConversionStatus status

The ConversionStatus object for conversion result.

CONSTRUCTOR & DESTRUCTOR

Syntax

CipherLab::DataConverter::Txt2DbfConverter::Txt2DbfConverter (BasicProgDataFormat
& dataFormat, const char *targetDir, WrongFormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2DbfConverter class in basic programming data
format.

Parameters
dataFormat
Reference to a BasicProgDataFormat object.
targetDir
The path for the output file(s).
actionTakenWhenWrong
The action to take when detecting wrong data format during conversion.

Syntax

CipherLab::DataConverter::Txt2DbfConverter: : Txt2DbfConverter (CProgDataFormat &
dataFormat, const char *targetDir, WrongFormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2DbfConverter class in C programming data format.

Parameters

45




Data Converter Programming Guide

dataFormat
Reference to a CProgDataFormat object.
targetDir
The path for the output file(s).
actionTakenWhenWrong
The action to take when detecting wrong data format during conversion.

Syntax

CipherLab::DataConverter::Txt2DbfConverter: : Txt2DbfConverter
(ForgeAgProgDataFormat & dataFormat, const char *targetDir, WrongFormatAction
actionTakenWhenWrong)

Initializes a new instance of the Txt2DbfConverter class in Forge AG programming data
format.

Parameters
dataFormat

Reference to a ForgeAgProgDataFormat object.
targetDir

The path for the output file(s).
actionTakenWhenWrong

The action to take when detecting wrong data format during conversion.

DETAILS OF MEMBER FUNCTION

Syntax

ConversionResult CipherLab::DataConverter::Txt2DbfConverter::Convert
(ProgressCallBack *cb)

Requests conversion.
Parameters
cb

A function pointing to the user-defined progress report function. If there is no
need to report progress, set cb to NULL.

Return Value
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Points to the ConversionResult object for conversion result.

Example

BasicProgDataFormat bpdf;

bpdf.setDelimiter(0x2C);

bpdf.DbfFileName = CipherLab::DataConverter::F2;

string path = "D:\\DcTestFolder\\testFiles\\D\\input_delimiter_15.txt";
bpdf.setPath(path.c_str());

bpdf.ParseRecordFields(bpdf.getPath());

bpdf.EditRecordFieldlsKey(1, true);

bpdf.EditRecordFieldLength(2, 3);

bpdf.EditRecordFieldlsKey(2, true);

Txt2DbfConverter* t2dObj = new Txt2DbfConverter(bpdf,
"D:\\DcTestFolder\\PC2SD\\Delimiter\\API", Skip);

ConversionResult result;

try{
result = t2dObj->Convert(NULL);
¥

by

catch(formatException& e)

{
cerr << e.getMessage() << endl;
getchar();
exit(0);

Syntax

void CipherLab::DataConverter::Txt2DbfConverter::ConvertAsync (ProgressCallBack
*cb)

Requests action of asynchronous conversion.
Parameters
cb

A function pointing to the user-defined progress report function. If there is no
need to report progress, set cb to NULL.
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Return Value

Points to the ConversionResult object for conversion result.

Syntax

void CipherLab::DataConverter::Txt2DbfConverter::CancelAsync ()

Requests cancellation of asynchronous conversion.

Example

CProgDataFormat cpdf;
cpdf.setDelimiter(0x2C);
cpdf.AddRecordField(RecordField(1,4, false));
cpdf.AddRecordField(RecordField(6,2, true));
cpdf.AddRecordField(RecordField(9,3, false));

cpdf.setDelimiter(0x2C);

cpdf.DbfFileName = "input_c";

string path = "D:\\DcTestFolder\\testFiles\\D\\input_delimiter_15.txt";
cpdf.setPath(path.c_str());

for(inti = O; i < cpdf.getNumberOfRecordFields(); i++)
{
RecordField a = cpdf.GetRecordFieldAt(i);

cout << "recordVector[" << i << "]" << " offset("” << a.Position << ") length(" <<
a.Length << ")" << endl;

}

Txt2DbfConverter* t2dObj = new Txt2DbfConverter(cpdf,
"D:\\DcTestFolder\\PC2SD\\Delimiter\\API", Skip);

try{
ConversionResult result;
ProgressCallBack* cbPtr = new ProgressCallBack();
cbPtr->SetCallBack(progressCallBack);
t2dObj->ConvertAsync(cbPtr);
result = t2dObj->result;

switch(result.status)
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{

case CipherLab::DataConverter::Failed:
cout << "Failed" << endl;
break;

case CipherLab::DataConverter::Cancelled:
cout << "Cancelled" << endl;
break;

case CipherLab::DataConverter::Unknown:
cout << "Unknown" << endl;

break;

case CipherLab::DataConverter::SucceededWithRecordsSkipped:

cout << "SucceededWithRecordsSkipped" << endl;
break;
case CipherLab::DataConverter::Succeeded:
cout << "Succeeded" << endl;
break;
default:
cout << "Totally Unknown" << endl;
¥
cout << "Output File Paths: " << endl;
for(inti = 0; i < result.getNumberOfOutputFiles(); i++)
{

cout << i << ") " << result.getOutputFilePaths(i) << endl;

cout << "ErrorRecord: " << endl;
for(inti = 0; i < result.getNumberOfErrorRecords(); i++)
{
ErrorRecord e = result.getErrorRecord(i);
cout << i<<"):";
cout << "filename =" << e.getFileName() << endl;
cout << e.getRecordNum() << endl;

cout << e.getRecordText() << endl;
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catch(formatException& e)

{
cerr << e.getMessage() << endl;
getchar();
exit(0);

}

1.5.14 TXT2PACKEDDBFCONVERTER

Public Member Function:

DLLEXPORT Txt2PackedDbfConverter (BasicProgDataFormat &dataFormat, const char
*target, WrongFormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in basic programming
data format.

DLLEXPORT Txt2PackedDbfConverter (CProgDataFormat &dataFormat, const char
*target, WrongFormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in ¢ programming data
format.

DLLEXPORT Txt2PackedDbfConverter (ForgeAgProgDataFormat &dataFormat, const char
*target, WrongFormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in Forge AG programming
data format.

DLLEXPORT Txt2PackedDbfConverter (BasicProgDataFormat *dataFormat_list, int n,
const char *target, WrongFormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in multiple basic
programming data formats.

DLLEXPORT Txt2PackedDbfConverter (CProgDataFormat *dataFormatList, int n, const
char *target, WrongFormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in multiple ¢ programming
data formats.

DLLEXPORT Txt2PackedDbfConverter (ForgeAgProgDataFormat *dataFormatList, int n,
const char *target, WrongFormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in multiple Forge AG
programming data formats.

DLLEXPORT ~Txt2PackedDbfConverter ()

Destructor of Txt2PackedDbfConverter Class.

DLLEXPORT void CancelAsync ()
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Requests cancellation of asynchronous conversion.

DLLEXPORT ConversionResult Convert (ProgressCallBack *cbPtr)

Requests conversion.

DLLEXPORT void ConvertAsync (ProgressCallBack *cb)

Requests action of asynchronous conversion.

Public Attribute:

ConversionResult result

The ConversionResult object for conversion result.

ConversionStatus status

The ConversionStatus object for conversion result.

CONSTRUCTOR & DESTRUCTOR

Syntax

CipherLab::DataConverter::Txt2PackedDbfConverter:: Txt2PackedDbfConverter
(BasicProgDataFormat &dataFormat, const char *target, WrongFormatAction
actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in basic programming
data format.

Parameters
dataFormat
Reference to a BasicProgDataFormat object.
target
The path for the output file(s).
actionTakenWhenWrong
The action to take when detecting wrong data format during conversion.

Syntax

CipherLab::DataConverter::Txt2DbfConverter: : Txt2DbfConverter (CProgDataFormat &
dataFormat, const char *targetDir, WrongFormatAction actionTakenWhenWrong)

Initializes a new instance of the Txt2DbfConverter class in C programming data format.

Parameters
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dataFormat
Reference to a CProgDataFormat object.
targetDir
The path for the output file(s).
actionTakenWhenWrong
The action to take when detecting wrong data format during conversion.

Syntax

CipherLab::DataConverter::Txt2PackedDbfConverter:: Txt2PackedDbfConverter
(CProgDataFormat & dataFormat, const char *target, WrongFormatAction
actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in ¢ programming data
format.

Parameters
dataFormat
Reference to a CProgDataFormat object.
target
The path for the output file(s).
actionTakenWhenWrong
The action to take when detecting wrong data format during conversion.

Syntax

CipherLab::DataConverter::Txt2PackedDbfConverter: : Txt2PackedDbfConverter
(ForgeAgProgDataFormat & dataFormat, const char *target, WrongFormatAction
actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in Forge AG programming
data format.

Parameters
dataFormat

Reference to a ForgeAgProgDataFormat object.
target

The path for the output file(s).
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actionTakenWhenWrong
The action to take when detecting wrong data format during conversion.

Syntax

CipherLab::DataConverter::Txt2PackedDbfConverter::Txt2PackedDbfConverter
(BasicProgDataFormat *dataFormat_list, int n, const char *target, WrongFormatAction
actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in multiple basic
programming data formats.

Parameters
dataFormat_list

Points to BasicProgDataFormat object(s) array.

The number of dataformat.
target
The path for the output file(s).
actionTakenWhenWrong
The action to take when detecting wrong data format during conversion.

Syntax

CipherLab::DataConverter::Txt2PackedDbfConverter::Txt2PackedDbfConverter
(CProgDataFormat *dataFormatList, int n, const char *target, WrongFormatAction
actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in multiple ¢ programming
data formats.

Parameters
dataFormat_list

Points to BasicProgDataFormat object(s) array.

The number of dataformat.

target

The path for the output file(s).
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actionTakenWhenWrong
The action to take when detecting wrong data format during conversion.

Syntax

CipherLab::DataConverter::Txt2PackedDbfConverter:: Txt2PackedDbfConverter
(ForgeAgProgDataFormat *dataFormatList, int n, const char *target, WrongFormatAction
actionTakenWhenWrong)

Initializes a new instance of the Txt2PackedDbfConverter class in multiple Forge AG
programming data formats.

Parameters
dataFormat_list

Points to ForgeAgProgDataFormat object(s) array.

The number of dataformat.
target

The path for the output file(s).
actionTakenWhenWrong

The action to take when detecting wrong data format during conversion.

DETAILS OF MEMBER FUNCTION

Syntax

ConversionResult CipherLab::DataConverter::Txt2PackedDbfConverter::Convert
( ProgressCallBack *cbPtr )

Requests conversion.
Parameters
cbPtr

A function pointing to the user-defined progress report function. If there is no
need to report progress, set cbPtr to NULL.

Return Value
Points to the ConversionResult object for conversion result.

Example
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BasicProgDataFormat bpdf = BasicProgDataFormat();
bpdf.setDelimiter(0x2C);

bpdf.DbfFileName = CipherLab::DataConverter::F1;

string path = "D:\\DcTestFolder\\testFiles\\D\\input_delimiter_15.txt";
bpdf.setPath(path.c_str());

bpdf.ParseRecordFields(bpdf.getPath());

bpdf.EditRecordFieldlsKey(0, true);
bpdf.EditRecordFieldlsKey(1, true);
bpdf.EditRecordFieldlsKey(2, true);

for(inti = O; i < bpdf.getNumberOfRecordFields(); i++)
{
RecordField a = bpdf.GetRecordFieldAt(i);

cout << "recordVector[" << i << "]" << " offset(" << a.Position << ") length(" <<
a.Length << ")" << endl;

}

Txt2PackedDbfConverter* t2dObj = new Txt2PackedDbfConverter(bpdf,
"D:\\DcTestFolder\\PC2SD\\Delimiter\\API\\output"”, Reformat);

try{
ConversionResult result;

ProgressCallBack* cbPtr = new ProgressCallBack();
cbPtr->SetCallBack(progressCallBack_txt2packedDbf);
result = t2dObj->Convert(cbPtr);

switch(result.status)

{

case CipherLab::DataConverter::Failed:
cout << "Failed” << endl;
break;

case CipherLab::DataConverter::Cancelled:
cout << "Cancelled” << endl;
break;

case CipherLab::DataConverter::Unknown:

cout << "Unknown" << endl;
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¥

break;

case CipherLab::DataConverter::SucceededWithRecordsSkipped:

cout << "SucceededWithRecordsSkipped" << endl;
break;
case CipherLab::DataConverter::Succeeded:
cout << "Succeeded" << endl;
break;
default:

cout << "Totally Unknown" << endl;

cout << "Output File Paths: " << endl;
for(inti = 0; i < result.getNumberOfOutputFiles(); i++)
{

cout << i << ") " << result.getOutputFilePaths(i) << endl;

for(inti = O; i < result.getNumberOfErrorRecords(); i++)
{

if (i == 0)

cout << "ErrorRecord: " << endl;

ErrorRecord e = result.getErrorRecord(i);

cout << i<<™:";

cout << "filename =" << e.getFileName() << endl;

cout << e.getRecordNum() << endl;

cout << e.getRecordText() << endl;

catch(formatException& e)

{

+

cerr << e.getMessage() << endl;
getchar();
exit(0);

Syntax
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void CipherLab::DataConverter::Txt2PackedDbfConverter::ConvertAsync
(ProgressCallBack *cb)

Requests action of asynchronous conversion.
Parameters
cb

A function pointing to the user-defined progress report function. If there is no
need to report progress, set cb to NULL.

Example

ForgeAgProgDataFormat fpdf = ForgeAgProgDataFormat();
fpdf.setDelimiter(0x2C);

fpdf.DbfFileName = CipherLab::DataConverter::FirstLookup;

string path = "D:\\DcTestFolder\\testFiles\\D\\input_delimiter_15.txt";
fpdf.setPath(path.c_str());

fpdf.ParseRecordFields(fpdf.getPath());

fpdf.EditRecordFieldlsKey(0, true);

ForgeAgProgDataFormat fpdfl = ForgeAgProgDataFormat();
fpdfl.setDelimiter(0x2C);

fpdfl.DbfFileName = CipherLab::DataConverter::FirstLookup;
path = "D:\\DcTestFolder\\testFiles\\D\\input_delimiter_15.txt";
fpdfl.setPath(path.c_str());
fpdfl.ParseRecordFields(fpdfl.getPath());
fpdfl.EditRecordFieldlsKey(O, true);

ForgeAgProgDataFormat a[2];
a[0] = fpdf;
a[1] = fpdfl;

Txt2PackedDbfConverter* t2dObj = new Txt2PackedDbfConverter(a, 2,
"D:\\DcTestFolder\\PC2SD\\Delimiter\\API\\ForgeAg\\output", Reformat);

try{
ConversionResult result;

ProgressCallBack* cbPtr = new ProgressCallBack();
cbPtr->SetCallBack(progressCallBack_txt2packedDbf);
t2dObj->ConvertAsync(cbPtr);
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result = t2dObj->result;

switch(result.status)
{
case CipherLab::DataConverter::Failed:
cout << "Failed"” << endl;
break;
case CipherLab::DataConverter::Cancelled:
cout << "Cancelled" << endl;
break;
case CipherLab::DataConverter::Unknown:
cout << "Unknown" << endl;
break;
case CipherLab::DataConverter::SucceededWithRecordsSkipped:
cout << "SucceededWithRecordsSkipped" << endl;
break;
case CipherLab::DataConverter::Succeeded:
cout << "Succeeded" << endl;
break;
default:

cout << "Totally Unknown" << endl;

cout << "Output File Paths: " << endl;
for(inti = 0; i < result.getNumberOfOutputFiles(); i++)
{

cout << i << ") " << result.getOutputFilePaths(i) << endl;

for(inti = 0; i < result.getNumberOfErrorRecords(); i++)
{
if i ==0)
cout << "ErrorRecord: " << endl;
ErrorRecord e = result.getErrorRecord(i);

cout<<i<<"™:";
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he

cout << "filename =" << e.getFileName() << endl;
cout << e.getRecordNum() << endl;

cout << e.getRecordText() << endl;

catch(formatException& e)

{

cerr << e.getMessage() << endl;
getchar();
exit(0);
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Chapter 2
.NET PROGRAMMING

Please prepare the necessary library file (CipherLab.Data.ConverterLib.dll) on the
CD-ROM before you start to write and implement your application.

In order for your application to run on 64-bit Windows, you must have Microsoft Visual
C++ 2008 Redistributable Package installed on the 64-bit Winodws machine. Set the
platform target property to ‘x86’ for your C# or VB projects.

For C# Projects:

) Right click the project in the solution explorer and open 'Properties’
2) Choose the Build tab

3) Set the Platform Target property to 'X86'

For VB Projects:

) Right click the project in the solution explorer and open 'Properties’
2) Choose the Compile tab

3) Press the Advanced Compile Options... button

4) Set the Target CPU property to 'X86’

2.1 CREATE A VISUAL C# APPLICATION

Follow these steps to create a Visual C# application in Visual Studio 2008.

) On the File menu, point to New, and then click Project.

#9 Microsoft ¥isual Studio

Edit Wiew Tool  Test Analye Window Help

Hew P || 5] Puoject.. Cil+Shift 0

Open Y| @ MebSite ShifttA1t+H

‘3 Ee.. Ctil+l

J Project From Existing Code...
A

Advanced Save Options...
@ Save All Ct+Shift+s

Subversion 4
0 Page Zetup...
=4 Print.. Chl+P
Recent Files 3
Recent Projects .4

Exit
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2) Select the Windows project type in the left pane and then the Windows Forms

3)

62

Application template in the right pane.

New Froject

Pioject tpes: Templates: | HET Framework 3.5 i | |§|
Srmart Device ”~ Yisnal Studio installed templates
Test B
Wini2 @ Windows Forms &pplication | [ Class Library
Deepiiea Ohfuscatnr [ WTF Application WEF Browssr Application
- Other Languages 'ECDns:ule & pplication [ Empty Project
Visnal Basic e : - _
- Visual C# tIE Wind owes Service &# WEF Custom Control Libraxy
Mindows @ WEPF User Control Librany E Wind oves Forms Contool Library
Web
Emart Device My Templates
Cifice -
Databaze L4 g wearch Online Templates...
Reporting
Test
WCF
Workflow 7
Al e Theem fe e T o —
A project for creating an apphication with a Windows Forms nser tnterface { NET Framewnork 3 5) |
Mammne: | WindowsFormsd pplication] |
Location: |D:".Ci1:uherlabDa1:aC0nverter W | E___EIDWSE... q
Sohution Mame: | WindowsForms& pplication] | Create directory for solution
[J&dd to Subversion
] [ Cancel

Copy the CipherLab.Data.ConverterLib.dll file to the project folder.

-

@©v| o« WindowsFormsApplicationl » WindowsFormsApplicationl »
Organize = Share with = Burn Mew folder
[ Favorites - Mame
Bl Desktop . bin
4 Downloads . obj
%# Dropbox | Properties
] Recent Places ||_¢, CipherLab.Data.ConverterLib.dll I
@& SkyDrive #] Forml.cs
#] Forml.Designer.cs
4 Libraries #] Program.cs
@ Documents 7 WindowsFormsApplicationl.csproj
J’ Music 3
[ Pictures
E Yideos
1M Computer

Date modified

1/14/2015 3:29 PM
1/14/2015 3:29 PM
1/14/2015 3:29 PM
1/12/2015 6:05 PM
1/14/201511:59 AM
1/14/201511:49 AM
1/14/201511:49 AM
1/14,/201511:58 AM




4) Right-click References and select Add Reference.

2% WindowsFormsApplication]l - Microsoft ¥isual Stodio

Chapter 2

File Edit ¥iew Project Build Debug Data  Tools Test Apalyee  Window Help

- S % By @9 - B p Debug > by CPT

(H__ = A = =

1 Explorer - Solution .. » [ 3 Form] .cs [Design]

&

[ Solution "WindowsFormshpplicatio
== @ WindowsFormsA pplicati

=2 .
=)

5) Click the Browse tab and select the
OK.

.NET Programming

CipherLab.Data.ConverterLib.dll file. Click

— ™y
Add Reference M
| MET | cOM | Projects| Browse | Recent|

Lookin: . WindowsFomsApplication - @' _?' = ‘
Mame - Date modified Ty

0 bin 1/14/2015 3:.54 PM Fi

| ohj 1/14/2015 3:54 PM Fi

.. Properties 1/14/20153:54 PM Fi
| % CipherLab,Data.ConverterLib.dll 1/12/2015 6:05 PM A
1 [l 3
File name: CipherLab.Data ConverterLib dl -
Files of type: [Componem Files (*.dll:* tlb:" olb:™ ocx;” exe:” manifest) - l

ok || cancel |
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6) You should include “using CipherLab.Data.ConverterLib” to use the System DLL file.

#0 WindowsFormsApplicationl - Microsoft ¥isual Studio

Fil: Edit View Eefactor Project Build  Debug  Dats  Tools  Test  Lpabvee  Window  Help

B~ -G o # B BB p Debug ~ Any CPU A L
O} =] =

Solution Explarer - 1 X Forml c2 " Fomnl ¢ [Desizn]

ENE ISR %

'_a Soluiic-_n 'WmdowsFomlsApP]ica_ﬁnn Husing Systen:
= (5] WindowsFormsA pplication using System_Collections Generic;

[=4] Properties uzing Swsten Componenthodel ;
o [ Refersnces using System_]]ata;

<2 CipherLab Dats Conver ﬁ::g gizt:m%figl’ng’

2 Bystemn using System.Text;

2 Byvetem Core ] 1

-3 Systemn Data. using CipherLab.Data.Converterlib;

7) Start to write your code.

2% WindowsFormsApplication] - Microsoft Yisnal Studio

File: Edit Wiew Refactor Project Build Debuz Data  Tools  Test Anslwee Window Help

- - S @ % Ea a9 B p Db - Ly CPU s
L G e =

Solution Explorer ~ 1 x Forml .cs|" Forml s [Design]

& FEE S %

| Soluﬁo_n -WhﬂowsFomsApl_J]jca_ﬁon Susing System.
= (5] WindowsFormsApplication uzing System_Collections Generic:
|=d| Properties using System Componenthodel ;

= [ References uzing System Data;
using Svatem Drawing;

<3 CipherLab Data Comnver using System Ling:

< System using Swstem Text;

A0 Bywstern Core uzing Svstem Windows Forms;

< Systemn Data busing Cipherlab. Data.Converterlib;

A0 Bwstern Data DataletExd:
«3 Bvstem. Deplowment

Hnamespace WindowsFormsfpplicationl

A0 Swstern Diawring 1] public partial class Forml : Foum
<0 Bvstern, Windows Forms i )
-3 Systern Xl 3] public Forml()
-3 Fystern. Xml Ling InitializeComponent();
.@ Forml cs string version = Generallnfo Version;
ﬁg Program.cs 3
- i
a2
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2.2 CREATE A VISUAL BASIC APPLICATION

Follow these steps to create a Visual Basic application in Visual Studio 2008.

) On the File menu, point to New, and then click Project.

29 Microsoft ¥isual Studio

File Edit Wiew Tools  Test Apalyze Window  Help

Hew P50 Proect.. Ct+Shift+l
Open 4 ; Web Site... Shift+ Alt+H
I 3 EFie.. Ctl+l
J Project From Existing Code. ..
=
Advanced Save Options..
gl Save sl Cril+Ehifthd
Subversion 3
[ = Page Zetup...
=4 Funt.. Ctl+P
Recent Files 3
Recent Projects 3
Exit

2) Select the Windows project type in the left pane and then the Windows forms
Application template in the right pane.

New Project

Templates: |NETFamework35 v |[(E1/E]

bl ¥isual Studio installed templates

(2] Windows Forms Application I i3] e Librraryr

[eee] WPF &pplication Fl WPF Browser Application

(A Comnole Application [%2] Empty Project
5 @ Windoues Service «e WPF Custom Control Library
i [+ WEF User Control Libracy %] Windows Forms Control Librany

My Templates

i Search Onling Templates...
)

|£L project for creating an application with a Windows uer interface (NET Framework 3.5 |

Hame: | Wind owzd pplication |
Location: |D:\Ciph£r1&bDat&Converher w | Browse. .
Solution Neme: | Windowsd pplication2 | [#] Create diveetory for solution

[ 44 to Subwversion

[ 0K ][ Cameel

65



Data Converter User Guide

3) Copy the CipherLab.Data.ConverterLib.dll file to the project folder.

Organize - Share with -

i Favorites
Bl Desktop
& Downloads
%# Drophox
=l Recent Places

& SkyDrive

. Libraries
@ Documents
J‘F Music
[&] Pictures
B videos

1M Camputer

4) Right-click WindowsApplication2 and then select Add Reference.

#% WindowsApplication? - Microsoft ¥isual Studio

Burn

m

@Ov| o« WindowsApplication2 » WindowsApplication2 »

MNew folder
Marme
J bin
, My Project
_ obj
[ 2] CipherLab.Data.ConverterLib.dil |

VB Forml.Designervh
VB Forml.wb

[ windowsApplication2.vbproj

- | +y | | Search Wi

Date modified

1/14/2015 3:29 PM
1/14,/2015 3:29 PM
1/14/2015 3:29 PM
1/12,/2015 6:05 PM
11/8/2007 &:02 AM
1/14,/20151:12 PM
1/14/20151:10 PM

File Edit Wiew Project Build Debug Data  Tools  Test  Analyee  Window  Help
RN RAr=A" N N REENEC - 5L b Debug + Ly CPTI - | [ 0x05 vﬁ’i@g
| = -] = =

ion Explorer - Wi

Forml.vb "~ Fomml vh [Design]

2 [2] E|09.1 |~{gForml

v | |§g (Declarations

'_: Solution "Windowsdpplication2' (1 ¢

mPublic Class Fornl

5 [ r—
=4 My Project [ Duid
[] Forml vb Rebuild
Clean
Publish...
Fun Code Analysiz
Calculate Code Metrics

Add

I Add Reference...

Add Bervice Reference. ..
&7, Wisw Class Diagram

Set as StartlUp Project

Debuz

(T3

Subversion

o

Cnf

> i

Eemove
Rename

Onload Project

Properties

Add Eolution to Subversion..
£dd Belected Projects to Subversion

|j’ Open Folder in Windows Explorer
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5) Click the Browse tab and then select the CipherLab.Data.ConverterLib.dll file.
Click OK.

i Y
ﬁg Add Reference m
| MET | COM | Projects| Browse | Hecent|
Lookin: |, WindowsApplicationZ2 - & ? B
Mame . Date modified Ty
\ bin 1/14/2015 4:25 PM Fi
. My Project 1/14/2015 4:25 PM Fi
.. obj 1/14,/2015 4:25 PM Fi
|% CipherLab.Data.ConverterLib.dll 1A22015605PM - A
4| 1 3
File name: CipherLab.Data ConverterLib dll -
Files of type: [Cnmpunent Files {~.dll;" tlb;" alb;” ocx;™ exe;” manifest) "]
OK I l Cancel ]
b

6) You should include “Imports CipherLab” to use the System DLL file.

2% WindowsApplication? - Microsoft Yizual Studio

File Edit ¥iew Pooject Buwild Debwg Data  Tools Test Apabvee  Window Help

G- S @ %G 9 S p Debg ~ 4ay CPU - | iy 05
) 2 e E

Holation Explorer - Solution ' - B 3 Forml ¥b " Fommi vb [Design]

& [E] | = Y |ﬁ(General)

'_: Solotion "Windowsbpplisation2' {1 ¢
- (% WindowsApplication?

|Inports Cipherlah Data . Converterlib |
L | |

7) Start to write your code.

#% WindowsApplication? - Microsoft ¥isual Stodio

File: Edit ¥iew Pioject DBuild Debmg  Data  Tools  Test  Apslyee  Window  Help

S-S E@ %590 F ] p Db - ey - | @ 05
ey 4 & B

Solution Explorer - Solution ' - L X Forml .vb -~ Forml vb [Design]

& [E] | = Y |ﬁ(General)

'_: Solution "Windowsdpplication2' {1 ¢
B 22 WindowsApplication?
[=d| My Froject i
=] Foomd +b = Fublic Class Forml
'j e Private Sub Forml_Load()
Dim version Az String
wversion = GeneralInfo Version
End Hub
End Claz=
|

Imports Cipherlab Data Converterlib
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2.3 CONVERTER DELEGATE

2.3.1PROGRESSCALLBACK DELEGATE

The ProgressCallback delegate is for the convert function acting as a callback function to
report the percentage, record count and status of conversion process.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public delegate void ProgressCallback(float value, long recordCount, string status);

Parameters
value

Type: float

Specifies the percentage of progress.
recordCount

Type: long

Specifies the current processed record count.
status

Type: string

Indicates the processing status.
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2.4 CONVERTER APl ENUMERATIONS

All the following examples refer to Programming in Visual Studio C#.

2.4.1 AGXTYPE

The AGXType enumeration defines the type of AGX format for 8-series.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dll)

Syntax

public enum AGXType

{
Series86,
Series86_Encrypted,
Others,
Others_Encrypted

Members
Series86
The AGX format type for the 8600 model.
Series86_Encrypted
The AGX format type for the 8600 model to support Forge AG 2.0 or later.
Others
The AGX format type for 8-series except for 8600.
Others_Encrypted

The AGX format type for 8-series except for 8600 to support Forge AG 2.0 or
later.
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2.4.2 BASICPROGDBFFILENAME

The BasicProgDbfFileName enumeration defines the DBF file names for the Basic
programming PC to RAM and PC to SD card conversions.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dll)

Syntax

public enum BasicProgDbfFileName
{

F1 =1,

F2,

F3,

F4,

F5

Members
F1

The filename part of the DBF file is F1.
F2

The filename part of the DBF file is F2.
F3

The filename part of the DBF file is F3.
F4

The filename part of the DBF file is F4.
F5

The filename part of the DBF file is F5.
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2.4.3 CONVERSIONSTATUS

The ConversionStatus enumeration defines the current status of conversion process.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dll)

Syntax

public enum ConversionStatus

{
Failed = -2,
Cancelled,
Unknown,
SucceededWithRecordsSkipped,
Succeeded
b
Members
Failed=-2
Conversion status is failed.
Cancelled
Conversion status is cancelled.
Unknown

Conversion status is unknown.
SucceededWithRecordsSkipped

Conversion status succeeds with some records skipped.
Succeeded

Conversion status succeeds.
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2.4.4 FORGEAGPROGDBFFILENAME

The ForgeAgProgDbfFileName enumeration defines the type of lookup file for Forge
AG programming record format.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public enum ForgeAgProgDbfFileName

{
FirstLookup = 1,
SecondLookup,
ThirdLookup

by

Members

FirstLookup

First lookup file.
SecondLookup

Second lookup file.
ThirdLookup

Third lookup file.

2.4.5 PROGRAMMING TOOL

The ProgrammingTool enumeration defines the programming tool employed by users
to program the application.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.DataConverterLib (in CipherLab.Data.ConverterLib.dll)
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public enum ProgrammingTool

{
C,

Basic,

Members

C programming tool.

Basic

Basic programming tool.

2.4.6 WRONGFORMATACTION

The WrongFormatAction enumeration defines the actions to take when encountering

wrong data format during conversion.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.DataConverterLib (in CipherLab.Data.ConverterLib.dll)

Syntax

public enum WrongFormatAction

{
Stop,

Reformat,
Skip

Members

Stop

Stop the conversion process when data format is not correct.

Reformat
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Truncate and reformat the data record when the format is not correct.
Skip

Skip the current record and continue with the next record.

2.5 CLASSES

25.1AGX

Reads data format from an AGX file.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dll)

Syntax

public static class AGX

Methods

Name Description

public Read Reads data format from an AGX file.

public DetermineType Reads the header of an AGX file to determine the AGX
format type of 8-series mobile computers.

2.5.2 BASICPROGDATAFORMAT

Defines record format for Basic programming conversions.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public sealed class BasicProgDataFormat: DataFormat

Constructors
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Name Description
public BasicProgDataFormat Initializes a new instance of the
BasicProgDataFormat class.
public BasicProgDataFormat(string, | Initializes a new instance of the
BasicProgDbfFileName, BasicProgDataFormat class with input file path,
WrongFormatAction) output DBF file name, and the action to take
when detecting wrong data format during
conversion.
public BasicProgDataFormat(string, | Initializes a new instance of the

BasicProgDbfFileName,
char, WrongFormatAction)

BasicProgDataFormat class with input file path,
output DBF file name, data delimiter, and the
action to take when detecting wrong data
format during conversion.

Properties

Name Description
public | Delimiter Gets or sets the delimiter character that is
used in the record to separate data.
public | KeyCount Gets the number of key fields
public | IsRecordDelimited Gets a value indicating whether the record
uses a delimiter character to separate data.
public | MaxRecordFields Gets the maximum number of fields
allowed.
public | NumberOfRecordFields Gets the number of data fields in a record.
public | Path Gets or sets the input file path
Methods
Name Description
public | AddRecordField(RecordField) Adds a record field to the data format.
public | AddRecordField(List<RecordField>) | Adds a list of record fields to the data
format.
public | GetRecordFieldAt Gets the record field at specified location.
public | ParseRecordFields Auto parses the lookup file to list of record
fields.
Fields
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Name Description

public DbfFileName | Identifies the output DBF file name.

public Keylndices Identifies the index of the key record.
public Keys Identifies the record fields of the key record.
Remarks

> The maximum number of record fields for both non-8600 models and 8600 model is
8.

) Txt2PackedDbf conversion:

For non-8600 model, the format can have 1—~3 key fields specified; as for 8600 model,
the format can have 0—5 key fields specified.

> Txt2Dbf conversion:

For non-8600 model, the format can have 0—3 key fields specified; as for 8600 model,
the format can have 0—5 key fields specified.

2.5.3 CONVERSIONRESULT

Gets the post conversion result including the possible ErrorRecord list and the output file
paths.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public sealed class ConversionResult

Constructors
Name Description
public Status Returns the defined type of ConversionStatus
enumeration.
public ErrorRecords Returns the array of ErrorRecord objects.
public OutputFilePaths Returns the array of output files’ path.
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Defines record format for C programming conversions.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dll)

Syntax

public sealed class CProgDataFormat : DataFormat

Constructors
Name Description
public CProgDataFormat Initializes a new instance of the CProgDataFormat
class.
public CProgDataFormat(string, | Initializes a new instance of the CProgDataFormat

WrongFormatAction)

class with input file path and the action to take
when detecting wrong data format during
conversion.

public CProgDataFormat(string, | Initializes a new instance of the CProgDataFormat
string, class with input file path, output DBF file name,
WrongFormatAction) and the action to take when detecting wrong data
format during conversion.
public CProgDataFormat(string, | Initializes a new instance of the CProgDataFormat

string, string,
WrongFormatAction)

class with input file path, output DBF file name,
data delimiter, and the action to take when
detecting wrong data format during conversion.

Properties

Name Description

public | Delimiter Gets or sets the delimiter character that is
used in the record to separate data.

public | IsRecordDelimited Gets a value indicating whether the record
uses a delimiter character to separate data.

public | KeyCount Gets the number of key fields

public | MaxRecordField Gets the maximum number of fields
allowed.

public | NumberOfRecordFields Gets the number of data fields in a record.
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public | Path Gets or sets the input file path
Methods
Name Description
public | AddRecordField(RecordField) Adds a record field to the data format.
public | AddRecordField(List<RecordField>) | Adds a list of record fields to the data
format.
public | GetRecordFieldAt Gets the record field at specified location.
public | ParseRecordFields Auto parses the lookup file to list of record
fields.
Fields
Name Description
public DbfFileName | Identifies the output DBF file name.
public Keylndices Identifies the index of the key record.
public Keys Identifies the record fields of the key record.
Remarks

» The maximum number of record fields for both non-8600 models and 8600 model is

8.

) Txt2PackedDbf conversion:

For non-8600 model, the format can have 1—8 key fields specified; as for 8600 model,
the format can have 0—8 key fields specified.

> Txt2DbfConversion:

For both non-8600 models and 8600 model, the format can have 0—8 key fields
specified.

2.5.5 DBF2TXTCONVERTER

Converts DBF or transaction (DAT) files on SD card to text files.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dll)

Syntax
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public class Dbf2TxtConverter

Constructors
Name Description
public Dbf2TxtConverter Initializes a new instance of the Dbf2TxtConverter
(ProgrammingTool, class with specific programming language, input
string, string) file path, and the output file path.
Methods
Name Description
public | CancelAsync Requests cancellation of conversion.
public | ConvertAsync Requests action of conversion.
public | Convert Requests conversion.
public | Convert with Callback Requests conversion with callback function.
public | ProgressChangedDelegate Raises the ProgressChanged event.
public | RunWorkerCompletedDelegate Raises the RunWorkerCompleted event.
Events
Name Description
public | ProgressChanged Occurs when user raises the ProgressChanged event.

public | RunWorkerCompleted | occurs when the conversion has completed, has been
canceled, or has raised an exception.

Example

using CipherLab.Data.ConverterLib;

static void Main(string[] args)

{
string source = "D:\\DCTester3\\transaction\\DBF1.DAT";
string target = "D:\\DBFL1.txt";

Dbf2TxtConverter t2TInstance = new Dbf2TxtConverter (ProgrammingTool.Basic,
source, target);

79




Data Converter User Guide

t2TInstance.ProgressChanged += new ProgressChangedEventHandler(Report);

t2TInstance.RunWorkerCompleted += new
RunWorkerCompletedEventHandler(Complete);

t2TInstance.ConvertAsync();

2.5.6 DELIMITERCHAR

Defines the character of delimiter.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public static class DelimiterChar

Fields

Name Description
public None The character represents 0x00.
2.5.7 ERRORRECORD

Records errors during processing data conversion.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public class ErrorRecord
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Constructors
Name Description
public ErrorRecord Initializes a new instance of the ErrorRecord class with
(string, long, input file path, the sequence of the record, the record text
string, bool) and whether the action to take when detecting wrong data
format during conversion is ‘skip’ or not.
Fields
Name Description
public filename Identifies the input filename.
public numOfLines Identifies the sequence of the record.
public textOfRecord Identifies the text of record.
public isSkip Identifies whether the action to take when detecting wrong
data format during conversion is ‘skip’ or not.
2.5.8 FORGEAGPROGDATAFORMAT

Defines record format for Forge AG programming conversions.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public sealed class ForgeAgProgDataFormat:DataFormat

Constructors
Name Description
public | ForgeAgProgDataFormat Initializes a new instance of the

ForgeAgProgDataFormat class.

public | ForgeAgProgDataFormat(string, | Initializes a new instance of the

ForgeAgProgDbfFileName, ForgeAgProgDataFormat class with input file

WrongFormatAction) path, output DBF file name, and the action to
take when detecting wrong data format during
conversion.

public | ForgeAgProgDataFormat(string, | Initializes a new instance of the
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ForgeAgProgDbfFileName, ForgeAgProgDataFormat class with input file
char, WrongFormatAction) path, output DBF file name, data delimiter,

and the action to take when detecting wrong
data format during conversion.

Properties

Name Description
public | Delimiter Gets or sets the delimiter character that is used in the
record to separate data.
public IsRecordDelimited Gets a value indicating whether the record uses a
delimiter character to separate data.
public | KeyCount Gets the number of key fields
public | MaxRecordField Gets the maximum number of fields allowed.
public | NumberOfRecordFields | Gets the number of data fields in a record.
public | Path Gets or sets the input file path
Methods
Name Description
public | AddRecordField(RecordField) Adds a record field to the data format.
public | AddRecordField(List<RecordField>) | Adds a list of record fields to the data
format.
public | GetRecordFieldAt Gets the record field at specified location.
public | ParseRecordFields Auto parses the lookup file to list of record
fields.
Fields
Name Description
public | ActionTakenWhenFormatlsWrong | Gets the wrong format action.
public | DbfFileName Identifies the output DBF file name.
public | Keylndices Identifies the index of the key record.
public | Keys Identifies the record fields of the key record.
Remarks
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> The maximum number of record fields for non-8600 models is 8; as for 8600, the
maximum number of record fields is 12.

) For both Txt2PackedDbf conversion and Txt2Dbf conversions, the format must have
one and only one key field specified.

2.5.9 GENERALINFO

This class represents the general information associated with the DLL file.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public static class Generallnfo

Fields
Name Description
public | Version Gets a string representing the version associated with the
DLL file.
2.5.10 RECORDFIELD

This class represents position, length, and key field information that define a record field
in the CipherLab data format.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public class RecordField
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Constructors
Name Description
public RecordField(int, Initializes a new instance of the RecordField class with data
int) position and length specified by integer values.
public RecordField(int, Initializes a new instance of the RecordField class with data
int, bool) position, data length, and a bool value that specifies
whether the field is a key field in the CipherLab format.
Fields
Name Description
public IsKey Gets or sets a value indicating whether this record field is a
key field.
public Length Gets or sets the Length of this data field.
public Position Gets or sets the start position of this data field.
2.5.11 TXT2DBFCONVERTER

Converts lookup (.txt) files to DBF files for the SD card device.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public class Txt2DbfConverter

Constructors
Name Description
public Txt2DbfConverter(DataFormat, | Initializes a new instance of the
string) Txt2DbfConverter class with specific data
format and the output file path.
Methods
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Name Description
public CancelAsync Requests cancellation of conversion.
public ConvertAsync Requests action of conversion.
public Convert Requests conversion without callback
function.
public Convert with Callback Requests conversion with callback function.
public ProgressChangedDelegate Raises the ProgressChanged event.
public RunWorkerCompletedDelegate | Raises the RunWorkerCompleted event.
Events
Name Description
public | ProgressChanged Occurs when user raises the ProgressChanged event.

public | RunWorkerCompleted | occurs when the conversion has completed, has been
canceled, or has raised an exception.

Fields

Name Description
public | errorList Returns a list of error records.
Example

using CipherLab.Data. ConverterLib;

public static void myCallback(int value)

{
Console.WriteLine("Progress: {0}", value);
by
static void Main(string[] args)
{

ForgeAgProgDataFormat[] fag=
AGX.Read("D:\\Work\\DataConverter\\AG_8600\\8600_Basic_Test1l.AGX");

List<DataFormat> forgeList = new List<DataFormat=();
for (inti = 0; i < fag.Length; i++)

{
DataFormat f = fag[i];
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Console.WriteLine("Action Taken: {O}",
((ForgeAgProgDataFormat)f).ActionTakenWhenFormatisWrong);

Console.WriteLing("********xf(Q} **"0);
for(int j = 0; j < f.NumberOfRecordFields; j++)
{

RecordField a = f.GetRecordFieldAt(j);
Console.WriteLine("IsKey: {0}", a.lsKey);
Console.WriteLine("Length: {0}", a.Length);
Console.WriteLine("Position: {0}", a.Position);
¥
Console.WriteLine("Delimieter = {0}", fag[i].Delimiter);
Console.WriteLine("Action = {0}",
fag[i].ActionTakenWhenFormatlsWrong);
if (i ==0)
fag[i].Path = "D:\\ 8600_Basic_Testl_12Fields.txt";
else if (i == 1)
fag[i].Path = "D:\\ 8600_Basic_Testl_ 11Fields.txt";
else
fag[i].Path = "D:\\ 8600 _Basic_Testl 10FieldsND.txt";
forgeList.Add((DataFormat)fag[i]);
¥

Txt2PackedDbfConverter ainstance = new
Txt2PackedDbfConverter(forgeList, "D:\\ AG_8600\\Testl Result\\aoutput",
fag[0].ActionTakenWhenFormatlsWrong);

ainstance.Convert(myCallback);

by

2.5.12 TXT2PACKEDDBFCONVERTER

Converts lookup (.txt) files to DBF files for the RAM device.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public class Txt2PackedDbfConverter

Constructors
Name Description
public Txt2PackedDbfConverter Initializes a new instance of the
(DataFormat, string) Txt2PackedDDbf class with specific data format
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and the output file path.

public Txt2PackedDbfConverter Initializes a new instance of the

(List<DataFormat=>, string) Txt2PackedDbfConverter class with a list of

data format and the output file path.

Methods

Name Description
public CancelAsync Requests cancellation of conversion.
public ConvertAsync Requests action of conversion.
public Convert Requests conversion
public Convert with Callback Requests conversion with callback function.
public ProgressChangedDelegate Raises the ProgressChanged event.
public RunWorkerCompletedDelegate | Raises the RunWorkerCompleted event.
Events

Name Description
public | ProgressChanged Occurs when user raises the ProgressChanged event.
public | RunWorkerCopmleted | occurs when the conversion has completed, has been
canceled, or has raised an exception.
Fields
Name Description

public | errorList Returns a list of error records.
Example

using CipherLab.Data. ConverterLib;

static void Main(string[] args)

{

//Txt2PackedDbf — Multiple files in C

List<DataFormat> cList = new List<DataFormat>();

CProgDataFormat cpdf = new CProgDataFormat();

cpdf.Delimiter =',';

cpdf.AddRecordField(new RecordField(1, 4, true));
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cpdf.AddRecordField(new RecordField(6, 2, true));
cpdf.AddRecordField(new RecordField(9, 3, true));
cpdf.AddRecordField(new RecordField(13, 7, true));
cpdf.AddRecordField(new RecordField(21, 4, true));
cpdf.AddRecordField(new RecordField(26, 4, true));
cpdf.AddRecordField(new RecordField(31, 2, true));
cpdf.AddRecordField(new RecordField(34, 2, true));
cpdf.DbfFileName = "CPCRAM1";

cpdf.Path = "D:\\DCTester\\CPC2RAM_M\\input8.txt";

cList.Add(cpdf);

CProgDataFormat cpdf2 = new CProgDataFormat();
cpdf2.Delimiter = ',';

cpdf2.AddRecordField(new RecordField(1, 4, true));
cpdf2.AddRecordField(new RecordField(6, 2, true));
cpdf2.AddRecordField(new RecordField(9, 3, false));
cpdf2.AddRecordField(new RecordField(13, 7, true));
cpdf2.AddRecordField(new RecordField(21, 4, true));
cpdf2.AddRecordField(new RecordField(26, 4, true));
cpdf2.AddRecordField(new RecordField(31, 2, true));
cpdf2.AddRecordField(new RecordField(34, 2, false));
cpdf2.DbfFileName = "CPCRAM2";

cpdf2.Path = "D:\\DCTester\\CPC2RAM_M\\input8_1.txt";
cList.Add(cpdf2);

Txt2PackedDbfConverter test = new Txt2PackedDbfConverter(cList,

"D:\\DCTester\\CPC2RAM_M\\Input8k2"”, WrongFormatAction.Stop);

test.ProgressChanged += new ProgressChangedEventHandler(Report);
test.RunWorkerCompleted += new

RunWorkerCompletedEventHandler(Complete);

}

test.ConvertAsync();

public static void Report(object sender, ProgressChangedEventArgs e)

{
+

Console.WriteLine("Current Percentage is = {0}", e.ProgressPercentage);

public static void Complete(object sender, RunWorkerCompletedEventArgs e)

{

if (e.Cancelled)

Console.WriteLine("Canceled™);

else

if (e.Result '= null)

{
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if (sender is Txt2PackedDbfConverter)
{

foreach (ErrorRecord record in ((Txt2PackedDbfConverter)sender).list)

{
Console.WriteLine("record.textOfRecord = {0},

record.textOfRecord);

}
¥
else
{
Console.WriteLine("so null");
3
}
if (e.Error = null)
{
Console.WriteLine(e.Error.Message);
3
else
{
// Finally, handle the case where the operation
// succeeded.
Console.WriteLine("Completed");
}

}
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2.6 CLASS METHODS

2.6.1 AGX.READ

Reads data format from a Forge AG (AGX) file.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public static ForgeAgProgDataFormat[] Read(
string path

Parameters
path
Type: string

Specifies the AGX file path.

Return Value
Type: CipherLab.Data.ConverterLib.ForgeAgProgDataFormat[]

The array contains Forge AG programming data format.

Remarks

The AGX.Read method won't fill the Path property of the ForgeAgProgDataFormat class.
Therefore, the Path property will always be null.

Example

using CipherLab.Data. ConverterLib;

ForgeAgProgDataFormat[] agxDataFormats = AGX.Read("D:\\Files\\MyAgx.agx");
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Reads the header of an AGX file to determine the AGX format type of 8-series.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public static AGXType DetermineType(string path) (

string path
)
Parameters
path
Type: string

Specifies the AGX file path.

Return Value

Type: CipherLab.Data.ConverterLib.AGXType

The defined type of AGXType enumeration.

Example

using CipherLab.Data. ConverterLib;

AGXType type = AGX.DetermineType("D:\\Files\\MyAgx.agx'');
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2.6.3 DATAFORMAT.ADDRECORDFIELD (RECORDFIELD)

Adds a RecordField to the DataFormat class.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public virtual void AddRecordField (

RecordField recordField

Parameters
recordField
Type: CipherLab.Data.ConverterLib.RecordField

Specifies the record field.

2.6.4 DATAFORMAT.ADDRECORDFIELD(LIST<RECORDFIELD>)

Adds a list of RecordFields to the DataFormat class.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public virtual void AddRecordField (

List<RecordField>

Parameters
List<recordField>

Type: List<CipherLab.Data.ConverterLib.RecordField>
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Specifies the list of record fields.

2.6.5 DATAFORMAT.GETRECORDFIELDAT

Gets a RecordField from the specified location.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public RecordField GetRecordFieldAt (

int index

Parameters
index
Type: int

Index of the record field.

2.6.6 DATAFORMAT.PARSERECORDFIELDS

Auto parses the lookup file to list of record fields.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public List<RecordField>ParseRecordFields (

string inputFilePath

Parameters
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inputFilePath
Type: string

The path of input lookup file.

2.6.7 DBF2TXTCONVERTER.CANCELASYNC

Requests cancellation of conversion.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public void CancelAsync()

Example

using CipherLab.Data. ConverterlLib;

Txt2DbfConverterConverter test = new Txt2DbfConverterConverter (bpdf,
"D:\\Work\\8200");

test.CancelAsync();

2.6.8 DBF2TXTCONVERTER.CONVERT

Requests action of conversion without callback request.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Example

using CipherLab.Data. ConverterLib;
Dbf2Txt t2TInstance = new Dbf2Txt(ProgrammingTool.Basic, source, target);

t2TInstance.Convert();

2.6.9 DBF2TXTCONVERTER.CONVERT WITH CALLBACK

Requests action of conversion with callback request.
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Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Example

using CipherLab.Data. ConverterLib;
Dbf2Txt t2TInstance = new Dbf2Txt(ProgrammingTool.Basic, source, target);

t2TInstance.Convert(callback);

2.6.10 DBF2TXTCONVERTER.CONVERTASYNC

Requests action of conversion.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Example

using CipherLab.Data. ConverterLib;
Dbf2Txt t2TInstance = new Dbf2Txt(ProgrammingTool.Basic, source, target);

t2TInstance.ConvertAsync();

2.6.11 DBF2TXTCONVERTER.PROGRESSCHANGEDDELEGATE

Raises the ProgressChanged event.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public delegate void ProgressChangedDelegate(Object sender,
ProgressChangedEventArgs e)

Parameters
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sender
Type: CipherLab.Data.ConverterLib.Dbf2TxtConverter

The current class which can raise an event.

e
Type: System.ComponentModel.ProgressChangedEventArgs
An EventArgs that contains the event data.

Example

using CipherLab.Data. ConverterLib;

Dbf2TxtConverter t2TInstance = new Dbf2TxtConverter(ProgrammingTool.Basic, source,
target);

t2TInstance.ProgressChanged += new ProgressChangedEventHandler(Report);
public static void Report(object sender, ProgressChangedEventArgs €)

{

Console.WriteLine("Current Percentage is = {0}", e.ProgressPercentage);

>

2.6.12 DBF2TXTCONVERTER.RUNWORKERCOMPLETEDDELEGATE

Raises the ProgressChanged event.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public delegate void RunWorkerCompletedDelegate(Object sender,
RunWorkerCompletedEventArgs e)

Parameters
sender
Type: CipherLab.Data.ConverterLib.Dbf2TxtConverter

The current class which can raise an event.
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e
Type: System.ComponentModel.RunWorkerCompletedEventArgs
An EventArgs that contains the event data.

Example

using CipherLab.Data. ConverterLib;

Dbf2TxtConverter t2TInstance = new Dbf2TxtConverter(ProgrammingTool.Basic, source,

target);

t2TInstance.RunWorkerCompleted += new
RunWorkerCompletedEventHandler(Complete);

public static void Complete(object sender, RunWorkerCompletedEventArgs €)

{
if (e.Cancelled)

{
Console.WriteLine("Canceled");
}
else
{
if (e.Error '= null)
{
Console.WriteLine(e.Error.Message);
¥
else
{
// Finally, handle the case where the operation
// succeeded.
Console.WriteLine("Completed™);
¥
¥
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2.6.13 TXT2DBFCONVERTER.CANCELASYNC

Requests cancellation of conversion.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public void CancelAsync()

Example

using CipherLab.Data. ConverterLib;

Txt2DbfConverter test = new Txt2DbfConverter(cpdf,
"D:\\Task\\DataConverter3\\Test"); test.CancelAsync();

2.6.14 TXT2DBFCONVERTER.CONVERT

Requests action of conversion without callback request.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Example

using CipherLab.Data. ConverterLib;

Txt2DbfConverter test = new Txt2DbfConverter(cpdf,
"D:\\Task\\DataConverter3\\Test");

test.Convert();

2.6.15 TXT2DBFCONVERTER.CONVERT WITH CALLBACK

Requests action of conversion with callback request.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)
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Example

using CipherLab.Data. ConverterLib;

Txt2DbfConverter test = new Txt2DbfConverter(cpdf,
"D:\\Task\\DataConverter3\\Test");

test.Convert(callback);

2.6.16 TXT2DBFCONVERTER.CONVERTASYNC

Requests action of conversion.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Example

using CipherLab.Data. ConverterLib;

Txt2DbfConverter test = new Txt2DbfConverter(cpdf,
"D:\\Task\\DataConverter3\\Test");

test.ConvertAsync();

2.6.17 TXT2DBFCONVERTER.PROGRESSCHANGEDDELEGATE

Raises the ProgressChanged event.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public delegate void ProgressChangedDelegate(Object sender,
ProgressChangedEventArgs e)

Parameters
sender

Type: CipherLab.Data.ConverterLib.Dbf2TxtConverter
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The current class which can raise an event.

e
Type: System.ComponentModel.ProgressChangedEventArgs
An EventArgs that contains the event data.

Example

using CipherLab.Data. ConverterLib;

Txt2DbfConverter test = new Txt2DbfConverter(cpdf,
"D:\\Task\\DataConverter3\\Test");

test.ProgressChanged += new ProgressChangedEventHandler(Report);
public static void Report(object sender, ProgressChangedEventArgs €)

{

Console.WriteLine("Current Percentage is = {0}", e.ProgressPercentage);

+

2.6.18 TXT2DBFCONVERTER.RUNWORKERCOMPLETEDDELEGATE

Raises the RunWorkerCompleted event.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public delegate void RunWorkerCompletedDelegate(Object sender,
RunWorkerCompletedEventArgs e)

Parameters
sender
Type: CipherLab.Data.ConverterLib.Txt2DbfConverter

The current class which can raise an event.

Type: System.ComponentModel.RunWorkerCompletedEventArgs
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An EventArgs that contains the event data.

Example

using CipherLab.Data. ConverterLib;

Txt2DbfConverter test = new Txt2DbfConverter(cpdf,
"D:\\Task\\DataConverter3\\Test");

test.RunWorkerCompleted += new RunWorkerCompletedEventHandler(Complete);

public static void Complete(object sender, RunWorkerCompletedEventArgs e)
{
if (e.Cancelled)
Console.WriteLine("Canceled™);
else
{
if (e.Error '= null)
Console.WriteLine(e.Error.Message);
else

Console.WriteLine("Completed™);

>

2.6.19 TXT2PACKEDDBFCONVERTER.CANCELASYNC

Requests cancellation of conversion.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public void CancelAsync()

Example

using CipherLab.Data. ConverterlLib;
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Txt2PackedDbfConverter test = new Txt2PackedDbfConverter(cList,
"D:\\DCTester\\Input8k2");

test.CancelAsync();

2.6.20 TXT2PACKEDDBFCONVERTER.CONVERT

Requests action of conversion without callback request.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Example

using CipherLab.Data. ConverterLib;

Txt2PackedDbfConverter test = new Txt2PackedDbfConverter(cList,
"D:\\DCTester\\Input8k2");

test.Convert();

2.6.21 TXT2PACKEDDBFCONVERTER.CONVERT WITH CALLBACK

Requests action of conversion with callback request.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Example

using CipherLab.Data. ConverterLib;

Txt2PackedDbfConverter test = new Txt2PackedDbfConverter(cList,
"D:\\DCTester\\Input8k2");

test.Convert(callback);

2.6.22 TXT2PACKEDDBFCONVERTER.CONVERTASYNC

Requests action of conversion.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)
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Example

using CipherLab.Data. ConverterLib;

Txt2PackedDbfConverter test = new Txt2PackedDbfConverter(cList,
"D:\\DCTester\\Input8k2");

test.ConvertAsync();

2.6.23 TXT2PACKEDDBFCONVERTER.PROGRESSCHANGEDDELEGATE

Raises the ProgressChanged event.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public delegate void ProgressChangedDelegate(Object sender,
ProgressChangedEventArgs e)

Parameters
sender
Type: CipherLab.Data.ConverterLib.Txt2PackedDbfConverter

The current class which can raise an event.

e
Type: System.ComponentModel.ProgressChangedEventArgs
An EventArgs that contains the event data.

Example

using CipherLab.Data. ConverterLib;

Txt2PackedDbfConverter test = new Txt2PackedDbfConverter(cList,
"D:\\DCTester\\Input8k2");

test.ProgressChanged += new ProgressChangedEventHandler(Report);

public static void Report(object sender, ProgressChangedEventArgs €)
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Console.WriteLine("Current Percentage is = {0}", e.ProgressPercentage);

}

2.6.24 TXT2PACKEDDBFCONVERTER.RUNWORKERCOMPLETEDDELEGATE

Raises the RunWorkerCompleted event.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public delegate void RunWorkerCompletedDelegate(Object sender,
RunWorkerCompletedEventArgs e)

Parameters
sender
Type: CipherLab.Data.ConverterLib.Txt2PackedDbfConverter

The current class which can raise an event.

e
Type: System.ComponentModel.RunWorkerCompletedEventArgs
An EventArgs that contains the event data.

Example

using CipherLab.Data. ConverterLib;
using CipherLab.Data. ConverterLib;

Txt2PackedDbfConverter test = new Txt2PackedDbfConverter(cList,
"D:\\DCTester\\Input8k2");

test.RunWorkerCompleted += new RunWorkerCompletedEventHandler(Complete);

public static void Complete(object sender, RunWorkerCompletedEventArgs €)
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if (e.Cancelled)
Console.WriteLine("Canceled™);
else
{
if (e.Error != null)
Console.WriteLine(e.Error.Message);
else

Console.WriteLine("Completed™);
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2.7 CLASS EVENTS

2.7.1 DBF2TXTCONVERTER.PROGRESSCHANGED

The event occurs when users raise the ProgressChanged event.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public event ProgressChangedEventHandler ProgressChanged

Example

using CipherLab.Data. ConverterLib;

Dbf2TxtConverter test = new Dbf2TxtConverter(ProgrammingTool.Basic, source, target);

test.ProgressChanged += new ProgressChangedEventHandler(Report);

2.7.2 DBF2TXTCONVERTER.RUNWORKERCOMPLETED

The event occurs when the conversion has completed, has been canceled, or has raised
an exception.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public event RunWorkerCompletedEventHandler RunWorkerCompleted

Example

using CipherLab.Data. ConverterLib;
Dbf2TxtConverter test = new Dbf2TxtConverter(ProgrammingTool.Basic, source, target);

test.RunWorkerCompleted += new RunWorkerCompletedEventHandler(Complete);
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2.7.3 TXT2DBFCONVERTER.PROGRESSCHANGED

The event occurs when users raise the ProgressChanged event.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public event ProgressChangedEventHandler ProgressChanged

Example

using CipherLab.Data. ConverterLib;

Txt2DbfConverter test = new Txt2DbfConverter(cpdf,
"D:\\Task\\DataConverter3\\Test");

test.ProgressChanged += new ProgressChangedEventHandler(Report);

2.7.4 TXT2DBFCONVERTER.RUNWORKERCOMPLETED

The event occurs when the conversion has completed, has been canceled, or has raised
an exception.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public event RunWorkerCompletedEventHandler RunWorkerCompleted

Example

using CipherLab.Data. ConverterlLib;

Txt2DbfConverter test = new Txt2DbfConverter(cpdf,
"D:\\Task\\DataConverter3\\Test");

test.RunWorkerCompleted += new RunWorkerCompletedEventHandler(Complete);
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2.7.5 TXT2PACKEDDBFCONVERTER.PROGRESSCHANGED

The event occurs when users raise the ProgressChanged event.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public event ProgressChangedEventHandler ProgressChanged

Example

using CipherLab.Data. ConverterLib;

Txt2PackedDbfConverter test = new Txt2PackedDbfConverter(cList,
"D:\\DCTester\\Input8k2");

test.ProgressChanged += new ProgressChangedEventHandler(Report);

2.7.6 TXT2PACKEDDBFCONVERTER.RUNWORKERCOPMLETED

The event occurs when the conversion has completed, has been canceled, or has raised
an exception.

Namespace: CipherLab.Data.ConverterLib

Assembly: CipherLab.Data.ConverterLib (in CipherLab.Data.ConverterLib.dlIl)

Syntax

public event RunWorkerCompletedEventHandler RunWorkerCompleted

Example

using CipherLab.Data. ConverterlLib;

Txt2PackedDbfConverter test = new Txt2PackedDbfConverter(cList,
"D:\\DCTester\\Input8k2");

test.RunWorkerCompleted += new RunWorkerCompletedEventHandler(Complete);
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